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About This Online Help

This guide explains how to use the BEA WebLogic Process Integrator™ Studio to 
create workflows.

The following topics are included:

n Chapter 1, “Getting Started with BEA WebLogic Process Integrator Studio,” 
describes how to log in to and exit the Studio, and provides a brief overview of 
the Studio interface. 

n Chapter 2, “Configuring Plug-Ins,” explains how to load and configure available 
plug-ins for BEA WebLogic Process Integrator. It also explains how to access 
the online help for individual plug-ins.

n Chapter 3, “Configuring Security,” describes how to set user and role 
permissions. It also describes how to map roles in BEA WebLogic Process 
Integrator to groups in WebLogic Server.

n  Chapter 4, “Configuring Business Organizations,” describes how to define a 
business organization and how to create a business calendar.

n Chapter 5, “Defining Users and Roles,” explains how to create and delete users 
and roles, add users to an organization, and reroute tasks between users and 
roles.

n Chapter 6, “Defining Business Operations,” describes how to define, update, and 
delete a business operation in the BEA WebLogic Process Integrator Studio.

n Chapter 7, “Working with Templates and Template Definitions,” explains how to 
create templates, template definitions, and workflow diagrams. It also describes 
how to export and import workflow packages.

n Chapter 8, “Defining Node Properties,” describes how to define the properties 
for the nodes or components available in BEA WebLogic Process Integrator.
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n Chapter 9, “Defining Actions,” explains how to define the following actions: 
task actions, workflow actions, integration actions, exception handling actions, 
and miscellaneous actions.

n Chapter 10, “Creating Workflow Expressions,” explains how to use the 
expression builder to create workflow expressions.

n Chapter 11, “Creating XPath Expressions Using the XPath Wizard,” describes 
how to use the XPath wizard to create XPath Expressions.

n Chapter 12, “Using the XML Finder to Access XML Entities,” explains how to 
use the XML Finder to find XML entities, and how to manage XML entities in 
the XML repository.

n Chapter 13, “Monitoring Workflows,” explains how to monitor workflows at run 
time.

What You Need to Know

This document is intended for any user involved in the workflow design process. It is 
assumed that you are familiar with Java programming, XML documentation structure 
(XPath language structure), and business processes involved in the design of 
workflows. 

e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the 
BEA Home page, click on Product Documentation or go directly to the “e-docs” 
Product Documentation page at http://e-docs.bea.com/.



BEA WebLogic Process Integrator Studio Online Help xiii

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by using 
the File—>Print option on your Web browser. (Be sure to first click anywhere within 
the HTML content frame you want to print, so that that frame is selected.)

The information in this online help is also provided in PDF format on the BEA 
WebLogic Process Integrator documentation CD-ROM and on the BEA corporate 
“e-docs” web site. You can open the PDF in Adobe Acrobat Reader and print the entire 
document (or a portion of it) in book format. To access the PDFs, open the BEA 
WebLogic Process Integrator documentation Home page, click the PDF files button 
and select the document you want to print.

If you do not have the Adobe Acrobat Reader, you can get it for free from the Adobe 
Web site at http://www.adobe.com/.

Related Information

The following BEA WebLogic Process Integrator documents contain information that 
will help you use this product:

n BEA WebLogic Process Integrator Javadoc

n BEA WebLogic Process Integrator Release Notes

n Installing and Configuring BEA WebLogic Process Integrator

n Learning to Use BEA WebLogic Process Integrator

n Programming BEA WebLogic Process Integrator Client Applications

n Using the BEA WebLogic Process Integrator Studio

n Using the BEA WebLogic Process Integrator Worklist
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Contact Us!

Your feedback on the BEA WebLogic Process Integrator documentation is important 
to us. Send us e-mail at docsupport@bea.com if you have questions or comments. 
Your comments will be reviewed directly by the BEA professionals who create and 
update the BEA WebLogic Process Integrator documentation.

In your e-mail message, please indicate that you are using the documentation for the 
BEA WebLogic Process Integrator 2.0 release.

If you have any questions about this release of BEA WebLogic Process Integrator, or 
if you have problems installing and running BEA WebLogic Process Integrator, 
contact BEA Customer Support through BEA WebSupport at http://www.bea.com. 
You can also contact Customer Support by using the contact information provided on 
the Customer Support Card, which is included in the product package.

When contacting Customer Support, be prepared to provide the following information:

n Your name, e-mail address, phone number, and fax number

n Your company name and company address

n Your machine type and authorization codes

n The name and version of the product you are using

n A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.
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italics Indicates emphasis or book titles.

monospace 
text

Indicates code samples, commands and their options, data structures and 
their members, data types, directories, and file names and their extensions. 
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace 
boldface 
text

Identifies significant words in code.

Example:

void commit ( )

monospace 
italic 
text

Identifies variables in code.

Example:

String expr

UPPERCASE 
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR

{ } Indicates a set of choices in a syntax line. The braces themselves should 
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should 
never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

Convention Item
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| Separates mutually exclusive choices in a syntax line. The symbol itself 
should never be typed.

... Indicates one of the following in a command line: 

n That an argument can be repeated several times in a command line

n That the statement omits additional optional arguments

n That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line. 
The vertical ellipsis itself should never be typed.

Convention Item
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CHAPTER

1 Getting Started with 
BEA WebLogic Process 
Integrator Studio

The following sections provide information to help you start using the BEA WebLogic 
Process Integrator Studio:

n Logging In to the Studio

n Overview of the Studio Interface

n Exiting the Studio

Logging In to the Studio

1. Select the first step in this procedure that is appropriate for your platform and 
working environment:

l To start the Studio from the Start Menu on a Windows system, go to step 2. 

l To start the Studio from a Command Prompt window on a Windows system, 
go to step 3.

l To start the Studio on a UNIX system, go to step 4.
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2. Choose Start→Programs→BEA WebLogic E-Business Platform→WebLogic 
Integration 2.0→WebLogic Process Integrator→Start Studio to display the 
Logon dialog box.

Go to step 5.

3. Go to the following directory:

wlintegration2.0\processintegrator\bin

wlintegration2.0 is the product directory in which you installed the BEA 
WebLogic Integration software.

Type studio at the prompt to display the Logon dialog box.

Go to step 5.

4. Go to the following directory:

wlintegration2.0/processintegrator/bin

wlintegration2.0 is the product directory in which you installed the BEA 
WebLogic Integration software.

Execute the studio.sh script by entering the following command at the 
prompt:

sh studio.sh 

The Logon dialog box is displayed.

5. Enter your user name and password in the appropriate fields. If you have not yet 
been assigned a user name and password for WebLogic Process Integrator, enter 
a default user name and password. For a list of default user names and passwords, 
see “WebLogic Process Integrator Default Users and Passwords” in Chapter 4, 
“Starting and Stopping BEA WebLogic Process Integrator Components,” in 
Installing and Configuring BEA WebLogic Process Integrator.

6. In the Server [:port] field, specify the system that is running the WebLogic 
Process Integrator server application as follows: 

t3://host:port

l host is the computer name or IP address of the system that is running the 
WebLogic Process Integrator server. Specify localhost if the server is 
running on the same computer as the Studio application.

l port is the number you specified for the listen port when you installed BEA 
WebLogic Server. The default is 7001
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To log in to clustered servers, enter the following in the Server[:port] field:

t3://host1,host2,host3:port

Here, host1, host2, and host3 are the computer names or IP addresses of the 
clustered WebLogic Process Integrator servers.

7. Click OK.

Overview of the Studio Interface

The following topics provide general information about the Studio user interface:

n Using the Menu Options

n Using the Folder Tree Display

n Using the Drawing Area Toolbar

n Toggling Between Normal and Interface Views

Using the Menu Options

File Menu

Choose File→Option to perform the functions described in the following table.

Menu Option Function

Logon Log on to the BEA WebLogic Process Integrator server.

Logoff Log off from the BEA WebLogic Process Integrator server.

Exit Log off from the BEA WebLogic Process Integrator server and 
exit the BEA WebLogic Process Integrator Studio.
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View Menu

Choose View→Option to perform the functions described in the following table.

Configuration Menu

Choose Configuration→Option to perform the functions described in the following 
table.

Menu Option Function

Refresh Update the information if changes are made to the database by 
other client applications.

Use color on flowcharts View the workflow diagrams in color or black and white.

Sync selection with tree Synchronize the workflow components in the folder tree 
hierarchy with the workflow components in the drawing area. 
For example, clicking the Start node in a workflow diagram 
opens the corresponding Start node folder in the folder tree 
hierarchy.

Look and feel Change the look and feel of the Studio display. The choices are:

n Metal

n CDE/Motif

n Windows

Interface View . . . Display additional visual objects to represent subworkflows, 
XML documents, and plug-ins. Selecting this menu item 
displays the Interface View Preferences dialog box. For details 
about setting interface view preferences, see “Setting Interface 
View Preferences” on page 1-8.

Menu Option Function

Organizations Define organizations that represent different business entities, 
geographical locations, or any other distinction relevant to the 
particular business of the company. For details about defining 
organizations, see Chapter 4, “Configuring Business 
Organizations.”



Overview of the Studio Interface

BEA WebLogic Process Integrator Studio Online Help 1-5

Tools Menu

Choose Tools→Option to perform the functions described in the following table.

Help Menu

Choose Help→Option to perform the functions described in the following table.

Business Operations Define business operations representing a method call on an EJB 
or Java Class instance. For details about defining business 
operations, see Chapter 6, “Defining Business Operations.”

Events Define event key expressions. For instructions, see “Defining an 
Event Key” on page 8-15.

Plugins View and configure the available plug-ins. For details about 
configuring plug-ins, see Chapter 2, “Configuring Plug-Ins.”

Permissions Define the user and role permission levels. For details about 
defining permission levels, see “Setting Permission Levels” on 
page 3-2.

Role Mappings Map the currently-defined roles to WebLogic Server groups. For 
details about mapping roles, see “Mapping Roles to WebLogic 
Server Groups” on page 3-4.

Menu Option Function

Menu Option Function

Export Package . . . Export workflow objects as a jar file. For details about exporting 
packages, see “Exporting Packages” on page 7-20.

Import Package . . . Import workflow objects from a jar file. For details about 
importing packages, see “Importing Packages” on page 7-22.

Show XML Finder . . . Display the XML finder dialog box. For details about using the 
XML finder, see Chapter 12, “Using the XML Finder to Access 
XML Entities.”
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Using the Folder Tree Display

The BEA WebLogic Process Integrator Studio interface contains a folder tree display, 
which follows standard explorer-type conventions. The following table describes 
various ways you can use the folder tree display.

Menu Option Function

Help Topics Access the online help files for the Studio.

Plugin Help Access the online help files for the loaded plug-ins.

About WebLogic Process 
Integrator Studio . . .

Provide software version information about the BEA WebLogic 
Process Integrator Studio.

To perform this task . . . Perform the following procedure . . .

Display information 
pertaining to an organization.

Select the organization from the Organization drop-down list 
at the top of the screen. The information displayed applies 
only to the selected organization.

Expand and view details 
about an item in the tree.

Double-click one of the following items to expand it and 
view details about the item:

n Templates

n Calendars

n Users

n Roles

n Routing

n Workload Report

n Statistics Reports

For example, double-click the Templates folder to display a 
list of workflow templates. Double-click a workflow 
template to display a list of all workflow template 
definitions. Expanding a particular workflow template 
definition displays folders containing the tasks, decisions, 
events, joins, starts, dones, and variables for that workflow 
template definition.
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BEA WebLogic Process Integrator allows you to have more than one workflow 
diagram open simultaneously so you can toggle back and forth among them.

Using the Drawing Area Toolbar

Use the shapes (representing the various nodes or components of a workflow) on the 
workflow toolbar to draw a workflow. Workflow shapes and connectors can be 
selected and dropped onto the workflow drawing area, allowing you to modify 
workflows as needed.

To open the workflow drawing area, create a new workflow template definition or 
open an existing one. For detailed instructions on performing these tasks, see 
Chapter 7, “Working with Templates and Template Definitions.” 

To place a shape in the drawing area:

1. Click the shape on the toolbar.

2. Place your cursor on the drawing area.

3. Click again to drop the shape onto the drawing area.

To move a shape within the diagram, click and drag the shape with your mouse.

Display menu options for an 
item in the tree.

Select an item in the folder tree and right-click the item to 
display a menu containing options relevant to the 
highlighted item. 

When you choose a menu option, a corresponding dialog 
box is displayed on the right-hand side of the screen. 
However, right-click menus in the folder tree are context 
specific. Depending on the context in which you are 
accessing the right-click menu, certain options may not be 
accessible. For example, if your security realm does not 
permit you to add users and roles to WebLogic Process 
Integrator, the Create Role and Add Users menu options will 
not be accessible to you.

To perform this task . . . Perform the following procedure . . .
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Relocating the Toolbar

By default, the workflow toolbar appears at the top of the drawing area. Depending on 
the size of your screen, the complete toolbar may not be visible. The toolbar cannot be 
resized. 

To move the toolbar to a different location on your screen:

1. Click the background area of the toolbar (for example, the space between the Draw 
Connection and Zoom Out shapes).

2. Holding down the mouse key, drag the toolbar to the desired location. Then 
release the mouse key.

Toggling Between Normal and Interface Views

Workflows often interact with different objects, such as subworkflows and EJBs. To 
see the objects with which a workflow interacts, you can display a workflow diagram 
using two views: normal and interface. A normal view displays the components in the 
workflow diagram, but not the objects with which the workflow interacts. 

An interface view displays the components in the workflow diagram, plus the 
following objects: subworkflows, business operations, outbound and inbound XML 
documents, and plug-ins.

When you open a template definition, a normal view is displayed. To display a 

workflow diagram using an interface view, click the  icon on the toolbar.

Note: If the interface view icon is not visible on your toolbar, you may need to move 
the toolbar to a different location on your screen. For instructions, see 
“Relocating the Toolbar” on page 1-8.

Setting Interface View Preferences

Within an interface view, you can choose which objects to display in the workflow 
diagram. To specify such objects:

1. Choose View→Interface View to display the Interface View Preferences dialog 
box.
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2. Select the check boxes for the objects you want to display, or clear the check 
boxes for the objects you do not want to display. 

The settings are system-wide; that is, they apply to all template definitions. They 
are saved from session to session in the Studio; they are not saved as part of the 
template definition.

For details about displaying workflow objects in an interface view, see “Toggling 
Between Normal and Interface Views” on page 1-8.

Viewing Inbound XML Document Data

In an interface view, the following icon represents an inbound XML document in the 
workflow diagram. 

Note: The arrow points toward the parent template node to indicate inbound 
direction.

An inbound XML document icon is displayed for start and event nodes that respond to 
incoming XML documents. Hover the mouse pointer over the XML document icon in 
the workflow diagram to display a text box that indicates the type (inbound or 
outbound), root, and key of the XML document.

Viewing Outbound XML Document Data

In an interface view, the following icon represents an outbound XML document in the 
workflow diagram. 

Note: The arrow points away from the parent template node to indicate outbound 
direction.
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An outbound XML document icon is displayed if either a Send XML to Client or Post 
XML Event action is defined for an object. You can obtain information about the XML 
document as follows:

n Hover the mouse pointer over the XML document icon in the workflow diagram 
to display a text box that indicates the type (inbound or outbound), root, and key 
of the XML document.

n Double-click the XML document icon to display the dialog box for the defined 
action (either Send XML to Client or Post XML Event). Alternatively, you can 
select the  icon, right-click it, and select Properties from the pop-up menu to 
display the appropriate dialog box.

For details about the Send XML to Client and Post XML Event actions, see “Send 
XML to Client” on page 9-31 and “Post XML Event” on page 9-24.

Viewing Subworkflow Data

In an interface view, the following icon represents a subworkflow in the workflow 
diagram. 

A subworkflow icon is displayed if a Start Workflow action is defined for an object. 
You can obtain information about the subworkflow as follows:

n Hover the mouse pointer over the subworkflow icon to display a text box that 
indicates the name of the called subworkflow.

n Double-click the icon to display the Start Workflow dialog box. Alternatively, 
you can select the subworkflow icon, right-click on it, and select Properties to 
display the Start Workflow dialog box.

For details about the Start Workflow action, see “Start Workflow” on page 9-17.

Viewing Business Operation Data

In an interface view, the following icon represents a business operation in the 
workflow diagram.
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A business operation icon is displayed if a Perform Business Operation action is 
defined for an object. You can obtain information about the business operation as 
follows:

n Hover the mouse pointer over the business operation icon in the workflow 
diagram to display a text box that indicates the name of the business operation to 
be performed. 

n Double-click the business operation icon to display the Perform Business 
Operation dialog box. Alternatively, you can select the icon, right-click it, and 
select Properties to display the Perform Business Operation dialog box. 

For details about business operations, see Chapter 6, “Defining Business Operations.”

Viewing Plug-In Data

In an interface view, the following icon, or a custom icon, represents a plug-in action 
in the workflow diagram.

 

If a node contains a plug-in action, you can obtain information about the action as 
follows:

n Hover the mouse pointer over the plug-in icon in the workflow diagram to 
display a text box that indicates a description of the plug-in action. 

n Double-click the plug-in icon to display the corresponding plug-in action dialog 
box. Alternatively, you can select the icon, right-click it, and select Properties to 
display the plug-in action dialog box.

Note: If a start, event, or done node contains a customized property defined by a 
plug-in, a small plug-in icon is displayed in the upper-right corner of the node 
icon.
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Exiting the Studio

1. To save changes to a workflow, right-click the workflow template definition and 
choose Save from the menu that is displayed.

2. Choose File→Exit. 

Note: If you try to exit the BEA WebLogic Process Integrator Studio without first 
saving your changes, a dialog box prompts you to save your changes.

3. Click Yes to save your changes and exit the Studio, No to exit the Studio without 
saving your changes, or Cancel to cancel the exit operation.
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CHAPTER

2 Configuring Plug-Ins

The following sections provide basic information about loading and viewing plug-ins 
in the BEA WebLogic Process Integrator:

n What Is a Plug-In?

n Accessing Plug-In Online Help

n Viewing Available Plug-Ins

n Loading a Plug-In

n Configuring a Plug-In

n Deleting a Configuration

What Is a Plug-In?

A plug-in is a group of Java classes that extends the functionality provided in selected 
workflow components. Plug-ins provide a way to customize existing BEA WebLogic 
Process Integrator features so they are more appropriate for your environment, and to 
add functionality that is specific to your environment. 

A plug-in can extend the functionality of the following workflow components:

n Actions

n Done nodes

n Event nodes

n Start nodes
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n Template definition properties

n Template properties

n Variable types

For further details about plug-ins, see the following documents:

n Chapter 3, “Working with Plug-Ins,” in Using the BEA WebLogic Process 
Integrator Studio

Accessing Plug-In Online Help

Help for all plug-ins is accessible from the main menu in the Studio. To access online 
help for a plug-in:

1. Choose Help→Plugin Help.

A menu of help files for available plug-ins is displayed.

2. Select the appropriate help from the menu.

The help is displayed in a Web browser using two frames. A list of contents is 
displayed in the left frame and a title page is displayed in the right frame.

3. Use the contents frame to navigate through the help system. 

The WebLogic Process Integrator plug-in framework supports context-sensitive 
HTML help and JavaHelp for plug-ins. To access context-sensitive plug-in help, press 
the F1 key when the plug-in-defined dialog box is displayed. 

Viewing Available Plug-Ins

To view a list of available plug-ins and the status of each, choose 
Configuration→Plugins from the main menu in the Studio. The Plugin configurations 
dialog box is displayed.
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The information displayed for each plug-in is explained in the following table.

You can also obtain information about a plug-in by selecting the plug-in from the list 
and clicking the About button.

Loading a Plug-In

1. From the main menu in the Studio, choose Configuration→Plugins.

The Plugin configurations dialog box is displayed.

2. Select the plug-in you want to load.

3. Click Load.

The status of the plug-in changes to Loaded in the list.

To configure the plug-in, see “Configuring a Plug-In” on page 2-4.

Plugin Name The name for the plug-in as specified by the plug-in software.

Status n Loaded—The plug-in is loaded.

n Initialized—The plug-in has been initialized but not loaded.

n Missing—The plug-in has a registered configuration but is not 
deployed or available.

n Error—The plug-in threw an exception when called, or requires a 
later version of the plug-in framework.

Start mode n Automatic—The plug-in is loaded each time the server is started.

n Manual—The plug-in must be loaded manually each time you start 
the server.

n Disabled—The plug-in cannot be loaded.

Version  The software version for the plug-in.

Vendor  The company that supplied the plug-in.
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Configuring a Plug-In

1. From the main menu in the Studio, choose Configuration→Plugins.

The Plugin configurations dialog box is displayed.

2. Select the plug-in you want to configure.

3. Click Update.

A configuration dialog box is displayed.

4. Select the start mode for the plug-in by clicking one of the following option 
buttons:

l Automatic—Select this option if you want to load the plug-in each time the 
server is started.

l Manual—Select this option if you want to load the plug-in manually, as 
required.

l Disabled—Select this option to disable the plug-in functionality.

Note: The start mode does not become effective until the next time the server is 
started.

5. Specify configuration settings for the plug-in as appropriate.

For details about defining configuration settings for a plug-in, see the online help 
for that plug-in. To access plug-in help, press the F1 key (for context sensitive 
plug-in help), or choose Help→Plugin Help from the main menu in the Studio 
and select the appropriate plug-in help from the menu.

6. Click OK, to complete the configuration, or Cancel, to cancel the operation.

Deleting a Configuration

You can delete a configuration for a plug-in if it is no longer needed. When you delete 
a configuration, you do not delete the plug-in itself; you just delete its registered 
configuration. 
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To delete a configuration:

1. From the main menu in the Studio, choose Configuration→Plugins to display the 
Plugin configurations dialog box.

2. Select the plug-in whose configuration you want to delete. 

Note: You cannot delete the configuration of a plug-in unless the status of that 
plug-in is Missing.

3. Click Delete. The registered configuration for the selected plug-in is deleted, but 
the plug-in remains visible in the Plugin configurations dialog box.

The following table describes the actions that occur when you restart the server 
after a plug-in configuration has been deleted.

If the server is restarted and the 
plug-in is . . .

Then . . .

Not deployed The plug-in manager does not search for the 
plug-in and the plug-in is not listed in the Plugin 
configurations dialog box.

Deployed The plug-in is automatically loaded using the 
default configuration values defined by the 
plug-in.
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CHAPTER

3 Configuring Security

The following sections provide basic information about configuring security in the 
BEA WebLogic Process Integrator:

n Understanding Security

n Setting Permission Levels

n Mapping Roles to WebLogic Server Groups

Understanding Security

In BEA WebLogic Process Integrator, you maintain security for your workflows and 
their resources by doing the following:

n Mapping role and user information in WebLogic Process Integrator to BEA 
WebLogic Server security realms

n Specifying levels of permission for roles and users to protect and control access 
to WebLogic Process Integrator functions

For details about BEA WebLogic Process Integrator security, see “Understanding 
Security” in Chapter 4, “Administering Data,” in Using the BEA WebLogic Process 
Integrator Studio.
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Setting Permission Levels

Within WebLogic Server, there are several predefined permission groups, or levels,  to 
which users and roles must belong in order to perform certain functions in WebLogic 
Process Integrator. Roles and users can perform the tasks shown in the following table 
only if they have the corresponding level of permission.

Permission Level Allows User or Role to . . .

Configure System Make application configuration changes, such as adding, 
updating, and deleting business calendar.

Configure Components n Define, update, and delete business operations

n Load and configure plug-ins

Administer User n Manage users, roles, and organizations

n Specify levels of permissions for users and roles

n Work with task routing specifications

Monitor Instance n Monitor instances, but not change them

n Monitor business calendars, but not change them

n Work with workload and statistics reports

Create Template Create templates

Update Template Update templates

Delete Template Delete templates

Execute Template Execute templates within a particular organization
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Setting User Permissions

A user inherits the levels of permissions for the role to which it belongs. You can add 
other levels of permission for a user that are not defined for the role to which it belongs, 
but you cannot remove the permissions a user inherits from the role to which it 
belongs. Any permissions you add to a user are specific to the user, and are not 
reflected in the role to which the user belongs.

To set permissions for a user:

1. From the main Studio window, choose Configuration→Permissions.

The Permissions dialog box is displayed. 

2. Select the Users tab (if it is not already selected).

The Permissions dialog box displays all the users in the organization and the 
permissions currently assigned. If a permission is checked, but grayed out, you 
cannot remove that permission because it was inherited from the role to which 
the user belongs.

3. Select or clear the check boxes as desired. 

4. Click OK to accept the changes, or Cancel to cancel the operation.

Setting Role Permissions

A role in WebLogic Process Integrator inherits the levels of permission from the 
WebLogic Server group to which it belongs. In the Studio, you can add or remove 
levels of permission for a role. Any changes you make to a role are reflected in the 
group to which the role belongs, and affect any other roles that belong to the group.

To set permissions for a role:

1. From the main Studio window, choose Configuration→Permissions.

The Permissions dialog box is displayed. 

2. Select the Roles tab.
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3. From the Organization drop-down list, select the organization for which you want 
to set the role permissions. A role can be a member of more than one 
organization.

The Permissions dialog box displays all the roles in the organization and the 
permissions currently assigned.

4. Select or clear the check boxes as desired. 

5. Click OK to accept the changes, or Cancel to cancel the operation.

Mapping Roles to WebLogic Server Groups

Use the following procedure to map currently-defined roles to WebLogic Server 
groups.

Note: When you create a new role, you can map the role to an existing WebLogic 
Server group or you can create a new group. For details, see “Creating a Role” 
on page 5-5.

1. From the main Studio window, choose Configuration→Role Mappings. 

The Role Mappings dialog box is displayed.

2. From the Organization drop-down list, select the organization containing the 
roles you want to assign to WebLogic Server groups. The current mappings are 
displayed in a table.

3. In the table, select the role or group you want to remap. 

A drop-down arrow appears to the right of the group name to be changed. 

4. Click the drop-down arrow and, from the drop-down list, select the new 
WebLogic Server group to which you want to map the role. 

5. Click OK to complete the procedure, or Cancel to cancel the operation.
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CHAPTER

4 Configuring Business 
Organizations

The following sections provide key concepts and procedures for configuring and 
working with business organizations in the WebLogic Process Integrator Studio:

n What Is a Business Organization?

n Adding an Organization

n Updating an Organization

n Deleting an Organization

n Creating a Business Calendar for an Organization

n Updating a Calendar

n Deleting a Calendar

What Is a Business Organization?

A business organization represents different business entities, geographical locations, 
or any other class of distinction that is relevant to the particular business of a company. 
Within BEA WebLogic Process Integrator, objects such as users, roles, templates, and 
business calendars can be mapped to one or more business organizations.
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Adding an Organization

1. From the main menu in the Studio, choose Configuration→Organizations to 
display the Define Organizations dialog box.

2. Click Add to display the Organization Properties dialog box.

3. Enter a meaningful ID for the organization in the Organization Id field.

4. From the Calendar Id drop-down list, select a calendar to assign to the 
organization. See “Creating a Business Calendar for an Organization” on page 
4-3 for details on creating business calendars.

5. Click OK.

Updating an Organization

1. From the main menu in the Studio, choose Configuration→Organizations to 
display the Define Organizations dialog box.

2. Select the organization to be updated.

3. Click Update to display the Organization Properties dialog box.

4. Make changes as needed to the Organization Id or Calendar Id field, and click 
OK.

Deleting an Organization

1. From the main menu in the Studio, choose Configuration→Organizations to 
display the Define Organizations dialog box.

2. Select the organization to be deleted.

3. Click Delete to display the Delete Organization dialog box.
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4. Click Yes to confirm or No to cancel.

Creating a Business Calendar for an 
Organization

1. Right-click Calendars in the folder tree, and choose Create Calendar to display the 
Calendar Properties dialog box.

2. Enter a meaningful name for the calendar in the Name field.

3. Select a time zone for the calendar from the Time Zone drop-down list.

4. Specify the period of time for which the calendar will be in effect, using the 
Period From and To calendar fields. 

5. Click OK to save your changes.

Adding Rules to a Business Calendar

1. In the calendar Properties box, click Add to display the Rule dialog box.

2. Select the Exclude or Include option button. Use Exclude to define the calendar 
rules by excluding date or time ranges from your calendar. Use Include to define 
the calendar rules by specifying date and time ranges to include in your calendar.

3. Define calendar rules as follows:

l Click Days to display the Days dialog box. Select the days to be included or 
excluded from the calendar and click OK. The rule is displayed in the Rule 
field of the calendar Properties box. 

Note: Hold the Ctrl key down while clicking your left mouse button to select 
more than one day of the week.

l Click Hours to display the Hours dialog box. Select the hours to be included 
or excluded using the From and To list boxes and click OK.
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l Click Date to display the Date dialog box. Select the specific date to be 
included or excluded and click OK.

l Click Month to display the Month dialog box. Select the month or months to 
be included or excluded from the calendar and click OK. 

Note: Hold the Ctrl key down while clicking your left mouse button to select 
more than one month of the year.

l Click Date Interval to display the Date Interval dialog box. Select the dates 
of the interval to be included or excluded, using the From and To calendar 
fields, and click OK.

4. Click OK on the Rule dialog box to return to the calendar Properties dialog box.

Note: You can update or delete a calendar rule by highlighting the rule in the 
Rules field of the dialog box, clicking the Update or Delete button, and 
following the prompts.

5. Click OK in the calendar Properties box to save the calendar, or click Cancel to 
cancel the operation.

Updating a Calendar

1. In the folder tree, right-click the calendar you want to update, and choose 
Properties.

2. Make the necessary changes using the procedures described in “Creating a 
Business Calendar for an Organization” on page 4-3.

3. Click OK to save the changes, or click Cancel to cancel the operation.
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Deleting a Calendar

1. Right-click the calendar you want to delete and choose Delete to display the Delete 
Calendar dialog box.

2. Click Yes to delete the calendar, or click No to cancel the operation.
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CHAPTER

5 Defining Users and 
Roles

The following sections provide information about defining users and roles in the BEA 
WebLogic Process Integrator Studio:

n What Are Users and Roles?

n Creating a User

n Adding a User to the Current Organization

n Removing a User from the Current Organization

n Updating User Properties

n Deleting a User from the Security Realm

n Creating a Role

n Updating a Role

n Deleting a Role

n Rerouting Tasks Between Users and Roles

See Also

n “Configuring Security” on page 3-1

n Chapter 4, “Administering Data,” in Using the BEA WebLogic Process 
Integrator Studio
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What Are Users and Roles?

Users and roles are defined as follows:

n A user is an individual defined in BEA WebLogic Process Integrator as someone 
who has permission to perform tasks. 

n A role is a common area of responsibility or ability, or an authorization level 
that is shared by a group of individuals. A role can be a member of only one 
organization, but you can use the same name in multiple organizations. For 
example, you can have a role named Supervisor defined in Org1 and Org2. The 
name of the role is the same but, in actual fact, the roles are different. Supervisor 
in Org1 is not the same as Supervisor in Org2, even though the names are the 
same.

Roles are mapped to groups in WebLogic Server. Using the previous roles and 
organizations as an example, you can map Supervisor in Org1 to a group called 
SupervisorOrg1, and Supervisor in Org2 to a group called SupervisorOrg2. 

For details about setting permission levels for users and roles, and mapping roles to 
WebLogic Server groups, see Chapter 3, “Configuring Security.”

Creating a User

Use this procedure to create a user in the WebLogic security realm. This capability is 
available only if the security realm is a manageable one. 

To create a user in the security realm and WebLogic Process Integrator database:

1. Right-click the Users folder, and select Create Users to display the Create User 
dialog box.

2. Complete the fields as described in the following table. Then click OK, to create 
the user, or Cancel, to cancel the operation.
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Adding a User to the Current Organization

Use this procedure to add a user who is already defined in the WebLogic Server 
security realm to the current WebLogic Process Integrator organization. This facility 
is accessible only if the BEA WebLogic Process Integrator Studio is operating within 
a manageable realm.

1. Right-click the Users folder, and select Add Users to display the Add Users dialog 
box.

A list of valid users is displayed. (Valid users are users registered in WebLogic 
Server.) 

2. Click the check box to the left of the user you want to add. 

3. Click OK.

The user is added to the folder tree. 

4. Right-click the user name in the folder tree, and choose Properties from the 
pop-up menu to display the User dialog box.

5. Complete the appropriate fields as described in the following table. Then click 
OK, to save the new user information, or Cancel, to cancel the operation.

In this field . . . Do this . . .

User Id Enter a unique ID for the user. The user enters this ID to log in 
to BEA WebLogic Process Integrator client applications.

Password and Re-enter 
Password

Enter a password for the user.

E-mail Address (Optional) Enter the e-mail address of the user.

Default Organization Select a default organization for the user.

Calendar (Optional) Select a business calendar for the user.
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Removing a User from the Current 
Organization

1. Right-click a user in the folder tree and choose Remove to display the Remove 
User dialog box.

2. Click Yes, to remove the user, or No, to cancel the operation.

Updating User Properties

1. Right-click a user in the folder tree and choose Properties to display the User dialog 
box.

2. Make the necessary changes to the E-mail Address, Default Organization, and 
Calendar fields.

3. Click OK, to save the new information, or Cancel, to cancel the operation.

In this field . . . Do this . . .

User Id Leave as is. (This field is already populated with the name of the 
user being added to the organization.)

E-mail Address Enter the e-mail address of the user.

Default Organization Assign a default organization to the user.

Calendar Select the appropriate business calendar for the user.  For details 
about this feature, see  “Creating a Business Calendar for an 
Organization” on page 4-3.
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Deleting a User from the Security Realm

To delete defined users from a manageable WebLogic Server security realm and 
WebLogic Process Integrator database:

1. Right-click the Users folder, and select Delete Users to display the Delete Users 
dialog box, which contains a complete list of valid users for the current 
organization.

2. Select the check box to the left of each user to be deleted, and click OK.

A dialog box prompts you to confirm your selection.

3. Click Yes to delete the selected user(s).

Creating a Role

Use this procedure to create a role in the WebLogic security realm. This capability is 
available only if the security realm is a manageable one. 

1. Right-click the Roles folder in the folder tree and choose Create Role from the 
menu to display the Role dialog box.

2. Complete the fields as described in the following table. Then click OK, to save 
the new role, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Id Enter a meaningful ID for the role.

Calendar Use the Calendar drop-down list to assign a business calendar to 
the role. See  “Creating a Business Calendar for an 
Organization” on page 4-3 for instructions on how to create a 
business calendar.

WLS Group Use the WLS Group drop-down list to assign the role to an 
existing group in WebLogic Server. 
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Note: To change the group to which a role is mapped, see “Mapping Roles to 
WebLogic Server Groups” on page 3-4. 

Updating a Role

1. Right-click the role in the folder tree and choose Properties from the menu to 
display the Role dialog box.

2. Complete the fields as shown in the following table. Then click OK, to save the 
update, or Cancel, to cancel the operation.

Map to a group with the 
same name as the role

Click this check box to create a new group in WebLogic Server 
with the same name as the role.

Members Select the check boxes to the left of the users that you will 
designate as members of this role.

In this field . . . Do this . . .

In this field . . . Do this . . .

Id Leave as is. (This field is already populated with the name of the 
role being updated.)

Calendar Use the Calendar drop-down list to change the calendar assigned 
to a role. 

Members n Clear the check box to the left of any user you want to 
unassign from the role. 

n Select the check box to the left of any user you want to 
assign to the role.
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Deleting a Role

Use this procedure to delete a role from the WebLogic Server security realm and 
WebLogic Process Integrator database. This capability is available only if the security 
realm is a manageable one. 

1. Right-click the role in the folder tree and choose Delete from the pop-up menu to 
display the Delete Role dialog box.

2. Click Yes, to delete the role, or No, to cancel the operation. 

Rerouting Tasks Between Users and Roles

Use the Routing feature to reroute tasks currently assigned to one user to another user 
or role for a specified period of time: 

1. Right-click Routing in the folder tree to display a menu containing two options: 
Open and Close. 

2. Choose Open to display the Routing dialog box. 

The Routing dialog box contains a list of defined routings that specifies users 
whose tasks are rerouted and the users or roles to whom the tasks are rerouted. 
The Effective and To dates represent the time period for which the tasks are 
rerouted.

Adding a Task Routing Specification

1. In the Routing dialog box, click Add to display the Reroute Tasks dialog box.

2. Complete the fields as shown in the following table. Then click OK to save the 
rerouting specification or Cancel to cancel the operation.
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Updating a Task Routing Specification

1. Right-click the Routing feature in the folder tree, and choose Open from the pop-up 
menu to display the Routing dialog box.

2. In the list of task reroutings that is displayed, highlight the task rerouting you 
want to update.

3. Click Update to display the Reroute Tasks dialog box.

4. Make changes as needed to the Route To, Effective, and Expiry values.

5. Click OK, to save the changes, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Route From From the drop-down list, select the user from which all tasks 
should be rerouted.

Route To From the drop-down list, select the User, User In Role, or Role 
to which all tasks should be rerouted and select the 
corresponding option button.

Note: When you assign a task to a User in Role, the system 
performs workload balancing by first reviewing the 
number of tasks assigned to all users in the role, 
selecting the user with the least number of assigned 
tasks, and assigning all of the rerouted tasks to this 
user.

Effective Using the calendar field, specify a date on which the task 
rerouting will become effective.

Expiry Using the calendar field, specify a date on which the task 
rerouting will expire.
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Deleting a Task Routing Specification

1. Right-click the Routing feature in the folder tree, and choose Open from the pop-up 
menu to display the Routing dialog box.

2. In the list of task routings that is displayed, highlight the task routing you want to 
delete.

3. Click Delete to display the Delete Reroute dialog box.

4. Click Yes, to delete the task rerouting, or No, to cancel the operation.

Refreshing the Rerouting Task List

Click Refresh on the Routing dialog box to refresh the rerouting task list and display 
any changes that have been made since you first invoked the Routing dialog box.
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CHAPTER

6 Defining Business 
Operations

The following sections provide key concepts and procedures for working with 
business operations in the BEA WebLogic Process Integrator Studio:

n What Is a Business Operation?

n Defining a Business Operation

n Updating a Business Operation

n Deleting a Business Operation

What Is a Business Operation?

In WebLogic Process Integrator, a business operation represents a method call on an 
EJB or Java Class instance. This method call is added to a workflow in WebLogic 
Process Integrator through the use of the Perform Business Operation action. The 
results of invoking this action can be assigned to appropriate workflow variables.

For additional information about business operations, see “Understanding Business 
Operations” in Chapter 4, “Administering Data,” in Using the BEA WebLogic Process 
Integrator Studio.

To display a list of currently defined operations or to add new operations, choose 
Configuration→Business Operations in the BEA WebLogic Process Integrator Studio 
main window. The Business Operations dialog box is displayed.
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Defining a Business Operation 

1. Choose Configuration→Business Operations in the BEA WebLogic Process 
Integrator Studio main window. The Business Operations dialog box is displayed.

2. Click Add to display the Define Business Operation dialog box.

3. Complete the fields as described in the following table.

In this field . . . Do this . . .

Business Operation Name Enter a label for the method that is meaningful to a business 
analyst. 

You might, for example, choose CheckInventory as the 
label for a method that returns the number of items available in 
stock.
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Defining Business Operations for Java Classes

1. Select the Java Class option button in the Define Business Operation dialog box.

2. Complete the fields displayed as follows:

Java Class

Session EJB

Entity EJB

Select the option button for the type of business operation that 
you are defining:

n Java Class—Used in a business operation that wraps a call 
to a standard Java class that is accessible on the server. In 
order for a Java class to be wrapped to the server, it must be 
a serializable class. Java classes are persisted through the 
workflow instance.  

For details about completing the fields displayed when 
you select this option, see “Defining Business Operations 
for Java Classes” on page 6-3.

n Session EJB—Used in a business operation that wraps a 
session-type EJB on the server. A session EJB is a 
server-side process EJB that acts as an interface between the 
server and the client. Although Session EJBs can be placed 
in workflow variables, they are not persisted with workflow 
instances. Instead they exist only for the life of the 
transaction in which they are created. 

For details about completing the fields displayed when 
you select this option, see  “Defining Business Operations 
for Session EJBs” on page 6-5.

n Entity EJB—used in a business operation that wraps an 
entity-type EJB on the server. An entity EJB represents an 
internal state of the WebLogic Process Integrator engine; 
the client accesses that state indirectly, through Session 
EJBs. Entity EJBs are persisted through the workflow 
instance. 

For details about completing the fields displayed when 
you select this option, see “Defining Business Operations 
for Entity EJBs” on page 6-6.

In this field . . . Do this . . .
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3. Click OK in the Define Business Operation dialog box to complete the operation. 
Click Cancel to cancel the operation.

If you click OK, the business operation is added to the list of valid business 
operations in the Business Operations dialog box. You can add additional 
business operations, and update and delete existing business operations by 
clicking Add, Update, or Delete in the Business Operations dialog box.

In this field . . . Do this . . .

Fully Qualified Java Class Name 1. Click the Set button to display the Java Class Name 
dialog box.

2. Enter a fully qualified Java class name (for example, 
java.lang.String), and click OK. 

The Java class name is displayed in the Fully 
Qualified Java Class Name field.

Method to Call 1. Use the  drop-down list to select a method to call when 
the business operation is invoked in the workflow. 
There are three types of Java class methods in the list:

l Constructor Type—These method types are first 
in the list and begin with the word String. A 
constructor method returns an object of the type 
you entered as the Java Class Name.

l Method Type—These method types are second 
in the list. They are invoked on Java objects and 
can return any type.

l Static Type—These are last in the list and begin 
with the word Static. Static methods require 
no object to be invoked and can return any type.

The Parameter Name and Parameter Type fields are 
populated with the parameter values of the selected 
method. 

2. Rename the parameter and give it a more meaningful 
name, if desired, by highlighting the parameter and 
clicking the Update button to display the Parameter 
dialog box. 

3. Change the parameter name in the Description field, 
and click OK.
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4. Click Done in the Business Operations dialog box when you have finished 
defining all of your business operations. 

Defining Business Operations for Session EJBs

1. Select the Session EJB option button in the Define Business Operation dialog box 
to display fields relevant to Session EJBs.

2. Complete the fields as described in the following table.

3. Click OK in the Define Business Operation dialog box to complete the operation. 
Click Cancel to cancel the operation.

If you click OK, the business operation is added to the list of valid business 
operations in the Business Operations dialog box. You can add additional 
business operations, and update and delete existing business operations by 
clicking Add, Update, or Delete in the Business Operations dialog box.

In this field . . . Do this . . .

JNDI Name for Session EJB From the  drop-down list, select the JNDI (Java Naming and 
Directory Interface) name for the Session EJB. 

JNDI is a service provided by WebLogic Server; like a  
database, this service stores objects. A Session EJB is an 
object stored in this service. Here, you are selecting the JNDI 
name for a Session EJB. 

Method to Call Select the method to call from the drop-down list. This list 
contains a list of methods (or operations) that you can 
perform on the Session EJB when the method is called. 

The Parameter Name and Parameter Type fields are 
populated with the parameter values of the selected method.

Parameters 1. Rename the parameter with a more meaningful name, if 
desired, by highlighting the parameter and clicking the 
Update button to display the Parameter dialog box.

2. Change the parameter name in the Description field, and 
click OK.

3. Repeat, as desired, for each parameter.
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4. Click Done in the Business Operations dialog box when you have finished 
defining all of your business operations. 

Defining Business Operations for Entity EJBs

1. Select the Entity EJB option button in the Define Business Operation dialog box to 
display fields relevant to entity EJBs.

2. Complete the fields as described in the following table.

3. Click OK in the Define Business Operation dialog box to complete the operation. 
Click Cancel to cancel the operation.

If you click OK, the business operation is added to the list of valid business 
operations in the Business Operations dialog box. You can add additional 
business operations, and update and delete existing business operations by 
clicking Add, Update, or Delete in the Business Operations dialog box.

In this field . . . Do this . . .

JNDI Name for Entity EJB From the drop-down list, select the JNDI (Java Naming and 
Directory Interface) name for an Entity EJB.

JNDI is a service provided by WebLogic Server; like a 
database, this service stores objects. An Entity EJB is an object 
stored in this service. Here, you are selecting the JNDI name 
for the Entity EJB. 

Method to Call Select the method to call from the drop-down list. The 
drop-down list contains a list of methods (or operations) that 
you can perform on the Entity EJB when the method is called.

The Parameter Name and Parameter Type fields are populated 
with the parameter values of the selected method. 

Parameters 1. Rename the parameter with a more meaningful name, if 
desired, by highlighting the parameter and clicking the 
Update button to display the Parameter dialog box.

2. Change the parameter name in the Description field, and 
click OK.

3. Repeat, as desired, for each parameter.
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4. Click Done in the Business Operations dialog box when you have finished 
defining all your business operations. 

Updating a Business Operation

1. Choose Configuration→Business Operations in the BEA WebLogic Process 
Integrator Studio main window to display the Business Operations dialog box.

2. Select the business operation to be updated. Click Update to display the Define 
Business Operation dialog box.

3. Make the desired changes, and click OK to accept the changes or Cancel to 
cancel the operation.

4. Click Done in the Business Operations dialog box to complete the operation.

Deleting a Business Operation

1. Choose Configuration→Business Operations in the BEA WebLogic Process 
Integrator Studio main window to display the Business Operations dialog box.

2. Select the business operation to be deleted, and click Delete. 

A dialog box asks you to confirm your decision.

3. Click Yes to delete the operation, or click No to cancel the delete operation.

4. Click Done in the Business Operations dialog box to complete the operation.
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CHAPTER

7 Working with 
Templates and 
Template Definitions

The following sections provide key information and procedures for working with 
templates and template definitions in BEA WebLogic Process Integrator:

n What Are Workflow Templates and Template Definitions?

n Creating a New Template

n Creating a New Template Definition

n Setting Template Definition Properties

n Defining Workflow Variables

n Defining Exception Handlers

n Opening an Existing Template Definition

n Creating the Workflow Diagram

n Saving and Closing a Template Definition

n Copying a Template Definition

n Printing a Template Definition

n Deleting Templates and Template Definitions

n Exporting and Importing Workflow Packages
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What Are Workflow Templates and Template 
Definitions?

A workflow template is a folder or a container in BEA WebLogic Process Integrator. 
Each workflow template represents a workflow and contains various definitions, or 
versions, of its implementations. These versions of a workflow template are called 
workflow template definitions and are identified in the folder tree by their Effective 
and Expiry dates.

Creating a New Template

1. Right-click the Templates folder in the BEA WebLogic Process Integrator main 
window.

2. Select Create Template from the pop-up menu to display the Template Properties 
dialog box.

3. Select the General tab (if it is not already selected).

Note: If one or more plug-ins are defined for workflow templates, there will be 
an additional tab for each defined plug-in. For details about completing the 
fields for the plug-in template properties, see the online help specific to the 
relevant plug-in. To access plug-in help, press the F1 key (for 
context-sensitive plug-in help), or choose Help→Plugin Help from the 
main menu in the Studio and select the appropriate plug-in help from the 
menu. 

4. Complete the fields as described in the following table.
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5. Click OK to create the new template, or Cancel to cancel the operation. The new 
workflow template is displayed under Templates in the folder tree of the BEA 
WebLogic Process Integrator main window.

Creating a New Template Definition

1. Right-click the workflow template that will contain the new workflow template 
definition in the folder tree.

2. Choose Create Template Definition from the pop-up menu to display the 
Template Definition dialog box.

The Template Definition dialog box contains two tabs:

l General—For assigning general workflow template definition values

In this field . . . Do this . . .

Name Enter a meaningful name for the workflow template. It must be 
unique within BEA WebLogic Process Integrator.

All workflow template definitions defined within this workflow 
template use this name for identification, once they are 
instantiated and become workflow instances.

Organizations Select the check box for one or more organizations under which 
you will define this workflow template.

All orgs Click this button to make the workflow template available to all 
organizations.

If you do so, the check boxes for all the organizations in the 
Organizations field are automatically checked. 

Clear orgs Click this button to make this workflow template unavailable to 
all organizations.

If you do so, the check boxes for all the organizations in the 
Organizations field are automatically unchecked. 
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l Exception Handlers—For assigning system and custom-defined workflow 
exception handlers to the workflow template definition.

Note: If one or more plug-ins are defined for workflow template definitions, 
there will be an additional tab for each defined plug-in. For details about 
completing the fields for the plug-in template properties, see the online 
help specific to the relevant plug-in. To access plug-in help, press the F1 
key (for context-sensitive plug-in help), or choose Help→Plugin Help 
from the main menu in the Studio and select the appropriate plug-in help 
from the menu

3. Click the General tab and complete the fields as specified in the following table.

4. Click the Exception Handlers tab.  Any exception handlers that have been created 
are displayed in the Exception Handlers field. 

5. Select a system-defined or custom exception handler to assign to the workflow 
template definition.

If no Exception handlers have been defined, you can define one in the Exception 
Handler Properties dialog box. To access this dialog box, click Add. 

In this field . . . Do this . . .

Effective Using the available drop-down list, specify an exact date on 
which the workflow template definition will become effective.

Expiry Select the Expiry check box if you want to specify an expiry date 
for the workflow template definition. (Setting an Expiry date is 
optional.) Specify the expiry date using the available drop-down 
list.

Note: If the Expiry option is not selected, the workflow 
template definition will always be valid and effective.

Enable auditing Click this check box to send audit and error messages to the 
WebLogic Process Integrator audit topic: wlpi.AuditTopic. 
The default JMS topic for audit entries is wlpi.AuditTopic, 
but you can change it in the config.xml file using the 
WebLogic Server Administration Console.

Notes (Optional) Use this free-form text field to enter general 
comments describing the workflow template definition.
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You can also update an existing exception handler in the Exception Handler 
Properties dialog box. To access this dialog box, highlight the exception handler 
in the list and click Update.

To delete an exception handler from the list, highlight the exception handler in 
the list and click Delete. A confirmation window is displayed. Click OK to 
confirm your intention to delete.

For detailed instructions about using the Exception Handler Properties dialog 
box, see “Defining Exception Handlers” on page 7-10.

6. Click OK to create the template definition, or Cancel to cancel the operation.

If you click OK, a default workflow template definition is displayed in the 
workflow drawing area with a toolbar containing drawing shapes used for 
defining the workflow template. The default workflow template definition 
contains three shapes: Start, Task, and Done. 

7. Modify and define properties for the default workflow template definition as 
needed.

Multiple workflow template definition diagrams can be opened simultaneously, and 
you can toggle among them in BEA WebLogic Process Integrator.

Setting Template Definition Properties

To specify the properties of a workflow template definition:

1. Open the Template Definition by right-clicking the workflow template definition 
in the folder tree and selecting Open from the pop-up menu.

2. Right-click anywhere in the workflow drawing area, and select Properties from 
the pop-up menu to display the Template Definition dialog box. Alternately, 
display the Template Definition dialog box by right-clicking the workflow 
template definition in the folder tree and selecting Properties from the pop-up 
menu.

The Template Definition dialog box contains two tabs:

l General—For changing general workflow template definition values as 
needed
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l Exception Handlers—For assigning system-defined and custom workflow 
exception handlers to the workflow template definition

Note: If one or more plug-ins are defined for workflow template definitions, 
there will be an additional tab for each defined plug-in. For details about 
completing the fields for the plug-in template properties, see the online 
help specific to the relevant plug-in. To access plug-in help, press the F1 
key (for context-sensitive plug-in help), or choose Help→Plugin Help 
from the main menu in the Studio and select the appropriate plug-in help 
from the menu.

3. Click the General tab and complete the fields as specified in the following table.

In this field . . . Do this . . .

Id Specify a workflow expression to be used by the system at run 
time, as a label that distinguishes instances of the same 
workflow template definition. For example, an instance of a 
workflow template definition can include date and time, invoice 
number, customer name, and other relevant information that 
differentiates it from others.

If you know the syntax of the expression you want to use, you 
can type the expression directly in the field. Alternatively, click 
the A+B button to display the Expression Builder dialog box. 
For details about using the Expression Builder, see Chapter 10, 
“Creating Workflow Expressions.”

Active Select this check box to make the workflow active and available 
for processing. A new workflow template is inactive by default; 
it must be activated before it can be processed.

Effective Using the available drop-down list, specify an exact date on 
which the workflow template definition will become effective 
and can be instantiated.

Expiry (Optional) Select the Expiry check box if you want to specify an 
expiry date for the workflow template definition. To  specify a 
date, use the available drop-down list.
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4. Click the Exception Handlers tab. Any exception handlers that have been created 
are displayed in the Exception Handlers field. 

5. Select a system-defined or custom exception handler to assign to the workflow 
template definition.

If no Exception handlers have been defined, you can define one in the Exception 
Handler Properties dialog box. To access this dialog box, click Add.

You can also update an existing exception handler in the Exception Handler 
Properties dialog box. To access this dialog box, highlight the exception handler 
in the list and click Update.

To delete an exception handler from the list, highlight the exception handler in 
the list and click Delete. A confirmation window is displayed. Click OK to 
confirm your intention to delete.

For detailed instructions about using the Exception Handler Properties dialog 
box, see “Defining Exception Handlers” on page 7-10.

6. Click OK to save your changes. If you click Cancel, any pending changes to the 
fields in the Template Definition dialog box are discarded.

Enable Auditing Select this check box to allow the workflow template definition 
analyst to send audit and error messages to the WebLogic 
Process Integrator audit topic: wlpi.AuditTopic. The 
default JMS topic for audit entries is wlpi.AuditTopic, but 
you can change it in the config.xml file using the WebLogic 
Server Administration Console.

Notes (Optional) Use this free-form text field to enter general 
comments describing the workflow template definition.

Last Changed On This is a read-only field showing the date on which the 
workflow template definition was last updated.

Last Changed By This is a read-only field showing the user ID of the last person 
to change the workflow template definition.

In this field . . . Do this . . .
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Defining Workflow Variables

Not all workflow template definitions require variables. However, for those workflow 
template definitions containing processes that require variables, you should define the 
variables before you begin defining the workflow template definition. You can also 
add variables as you create a workflow template definition.

For details about using variables, see “Understanding Variables” in Chapter 6, 
“Working with Workflow Components,” in Using the BEA WebLogic Process 
Integrator Studio.

To define a variable:

1. In the folder tree, right-click the appropriate workflow template definition and 
choose Open from the pop-up menu.

2. In the folder tree, right-click Variables under the workflow template definition, 
and choose Create Variable to display the Variable Properties dialog box.

3. Complete the fields as described in the following table. Then click either OK, to 
complete the definition of the variable, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Name Enter a meaningful name for the variable, such as ItemNumber.

Type Select the type of variable from the Type drop-down list. The 
available types are Boolean, Date, Double, Entity EJB, Integer, 
Java Object, Session EJB, String, and XML.

Note: If a plug-in has been defined for variables, the 
drop-down list will contain the plug-in-defined 
variables. For details about such variables, see the 
online help specific to the relevant plug-in. To access 
plug-in help, press the F1 key (for context-sensitive 
plug-in help), or choose Help→Plugin Help from the 
main menu in the Studio and select the appropriate 
plug-in help from the menu. 
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Modifying Variable Definitions

1. Right-click an existing variable in the folder tree and choose Properties from the 
pop-up menu to display the Variable Properties dialog box.

2. Make changes to the variable as needed, and click OK.

Viewing Variable Usage

1. In the folder tree, right-click the appropriate workflow template definition and 
choose Open from the pop-up menu.

2. Right-click the variable in the folder tree and choose Usage from the pop-up 
menu to display the Variable Usage dialog box.

The Variable Usage dialog box lists, for a particular workflow template 
definition, the nodes in which the selected variable is used and the value 
assigned to that variable. Variables can be used in all workflow nodes except 
joins and dones.

3. Click OK to close the dialog box.

Parameter Specify whether the variable is an input or an output variable by 
checking the appropriate box. If you check the Input box, choose 
whether the parameter is mandatory by checking the Mandatory 
box. 

Notes (Optional) Use this free-form text field to make notes about the 
variable.

In this field . . . Do this . . .
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Defining Exception Handlers

The workflow exception handling facility enables you to generate, trap, and respond 
to internally and externally generated exception conditions at run time. Exceptions 
may be abnormal conditions that you define within the workflow, or they may be 
typical run-time server exceptions that you trap and respond to accordingly.

Exception handling within WebLogic Process Integrator is performed at the workflow 
level, rather than at the task level. All workflow template definitions have at least one 
exception handler, the system exception handler. The system exception handler, is by 
default, the initial exception handler and is invoked whenever an exception occurs. The 
system exception handler responds to exceptions by marking the active transaction for 
rollback only and rethrowing the exception to the client.

You can define customized exception handlers to act as the initial exception handler 
and specify actions to be executed in response to exceptions. For details on exception 
handlers, see Chapter 9, “Handling Workflow Exceptions,” in Using the BEA 
WebLogic Process Integrator Studio.

To define an exception handler:

1. In the folder tree, right-click the Exception Handlers folder (located within the 
selected workflow template definition folder), and select Create Exception Handler 
to display the Exception Handler Properties dialog box.

Note: You can also define exception handlers by accessing the Exception 
Handlers tab of the Template Definition Properties dialog box.

The Exception Handler Properties dialog box allows you to define actions for 
commit and rollback exception situations. You can also define workflow 
variables to be populated by values from the XML message defined within the 
Invoke Exception Handler action.

2. Complete the fields in the Exception Handlers Properties dialog box as described 
in the following table. Then click either OK, to complete the operation, or 
Cancel, to cancel the operation. 
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In this field . . . Do this . . .

Name Enter a meaningful and easily identifiable name for the new 
exception handler.

Initial Exception Handler Select this check box if you want to mark the exception handler 
as the default initial exception handler in the workflow. When a 
workflow encounters an exception, this is the first exception 
handler that is called.

Variables tab 1. Select this tab, if it is not already selected, to assign 
workflow variables to be populated by values from an XML 
message defined in either the Invoke Exception Handler 
action or the API.

2. Click Add to display the Workflow Variable Assignment 
dialog box.

3. Select the variable to which to assign the XML expression 
from the drop-down list. The variables in the drop-down list 
are those defined in the Variables Properties dialog box.

4. Enter a valid  expression to be assigned to the variable in the 
Event Expression field. 

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”

5. Click OK to complete the operation or Cancel to cancel the 
operation.

Actions on Commit tab 1. Select this tab to assign actions to be performed if the 
current active transaction is not marked for rollback only.

2. Click Add or Update to display the Add Action dialog box. 

3. Add actions as desired. For information about adding 
actions, see Chapter 9, “Defining Actions.”
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Opening an Existing Template Definition

To open an existing workflow template definition, right-click the workflow template 
definition in the folder tree, and choose Open from the pop-up menu. 

Actions on Rollback tab 1. Select this tab to assign actions to be performed if the 
currently active transaction is programmatically marked for 
rollback only. This type of rollback restores the workflow to 
the beginning of the currently active transaction. 

Only the following actions are available: Post XML Event, 
Call Program, Perform Business Operation, Exit Exception 
Handler, No Operation, and Make Audit Entry.

2. Click Add or Update to display the Add Action dialog box. 

3. Add actions as desired. For information about adding 
actions, see Chapter 9, “Defining Actions.”

Notes tab (Optional) Click this tab and enter any notes about the action in 
the free-form text field.

In this field . . . Do this . . .

If  there are. . . Then . . .

No instances of this 
workflow running on the 
server

The workflow template definition opens and the workflow 
diagram is displayed in the workflow drawing area.
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Creating the Workflow Diagram

After you first create a workflow template definition, the workflow toolbar and 
workflow drawing area are displayed on the right side of the WebLogic Process 
Integrator Studio main window.

By default, the drawing area already contains three nodes that you must define: start, 
task, and done.

Adding Nodes to a Diagram

1. If you want to add a node to an existing workflow diagram, right-click the 
workflow template definition in the folder tree and choose Open from the pop-up 
menu. The workflow diagram is opened.

2. In the toolbar, click the shape that you want to add to the diagram.

3. Click the location in the workflow diagram at which you want to drop the shape. 
To move a shape within the diagram, click and drag the shape with your mouse.

Instances of this 
workflow running on the 
server

The Existing Instances dialog box is displayed. This dialog box 
warns that changing a workflow template definition might cause 
a problem with the workflow template definitions currently in 
process. 

Select one of the following options:

n Open Read-Only—Opens the selected workflow template 
definition for viewing purposes only. You cannot modify 
the workflow in this mode.

n Open—Opens the selected workflow template definition for 
viewing and updating.

n Cancel—Closes this dialog box. The workflow template 
definition remains closed.

If  there are. . . Then . . .
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4. Repeat steps 2 and 3 until you have added all the necessary nodes to the diagram.

5. Define the nodes as described in Chapter 8, “Defining Node Properties.”

Deleting a Node from a Diagram

1. Delete a node from a workflow diagram in one of two ways:

l Select the shape in the drawing area, right-click the node, and choose Delete 
from the pop-up menu.

l In the folder tree, right click the node and choose Delete from the pop-up 
menu. 

A dialog box asks you to confirm your decision.

2. Click Yes to delete the node. Click No to cancel the delete operation.

Connecting Nodes in a Diagram

You can connect the nodes in a diagram through either of two procedures.

To connect nodes using the . . . Use the following procedure . . .

Connector icon on the toolbar 1. Click the connector arrow on the toolbar.

2. Click the shape from which you want to 
connect.

3. Continue to hold down the left mouse button 
and drag the connector to the shape that you 
want to connect to the first shape.
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Saving and Closing a Template Definition

In the BEA WebLogic Process Integrator folder tree, an asterisk (*) appears to the left 
of each workflow template definition that must be saved. 

You can save and close a template definition using one of the following procedures.

Properties dialog box 1. Double-click the node in the diagram to 
display the corresponding Properties dialog 
box.

2. Click the Next tab to display a list of nodes in 
the workflow. 

In the Join Properties dialog box, the list of 
nodes is displayed in the Next section of the 
dialog box.

3. Select the check box to the left of the shape 
that should come next.

4. Click OK to complete the operation or 
Cancel to cancel the operation.

To connect nodes using the . . . Use the following procedure . . .
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To save and close a workflow 
template definition from the . . .

Perform the following steps . . .

Folder tree 1. Right-click the workflow template 
definition and choose Close from the 
pop-up menu.

A dialog box asks whether you want to 
save your changes. 

2. Click Yes to save your changes and 
close the template definition. Click No 
to close the template definition without 
saving your changes. Click Cancel to 
cancel the close operation.

Note: To save the template definition 
without closing, choose Save from 
the pop-up menu.

Workflow drawing area 1. Right-click in the drawing area and 
choose Close from the pop-up menu.

A dialog box asks whether you want to 
save your changes.

2. Click Yes to save your changes and 
close the template definition. Click No 
to close the template definition without 
saving your changes. Click Cancel to 
cancel the close operation. 

Note: To save the template definition 
without closing, choose Save from 
the pop-up menu.
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Copying a Template Definition

BEA WebLogic Process Integrator allows you to take an existing workflow template 
definition, copy it, and paste it, as a new workflow template definition, into the folder 
tree. When you copy a workflow template definition in this way, all the properties 
assigned to it are copied, as well.

In addition, BEA WebLogic Process Integrator allows you to copy nodes (shapes) 
within workflow template definitions and paste them into either the current workflow 
template definition or other open workflow template definitions. All properties 
assigned to nodes are copied, as well.

Note: The copied (new) workflow template definition is not marked active. You 
must mark it active in the workflow Template Definition Properties dialog box 
in order for it to be processed in the workflow.

Copying Entire Workflow Template Definitions

To create a new workflow template definition based on an existing workflow template 
definition and its assigned properties, complete the following procedure:

1. In the folder tree, right-click the workflow template definition to be copied, and 
choose Copy from the pop-up menu. 

A copy of the selected workflow template definition is instantly pasted into the 
folder tree as the last workflow template definition, and the new workflow 
template definition is opened and displayed in the drawing area. The new 
workflow template definition contains the same effective and expiry dates as the 
original workflow template definition. 

2. Rename the new workflow template definition as follows:

c. Right-click anywhere in the drawing area and choose Properties from the 
pop-up menu to access the Template Definition dialog box. 

d. Modify the Expiry and Effective dates to change the name of the workflow 
template definition in the folder tree and reflect the new dates.
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Copying Nodes Within Workflow Template Definitions

You can copy a shape representing a node within a workflow template definition and 
paste it into any open workflow template definition, including the current one. Any 
properties that have been defined within the node are also copied. 

To copy a node to an open workflow template definition:

1. Click the node that you will copy.

2. Right-click in the drawing area, and select Copy from the pop-up menu.

3. Place your cursor in the appropriate open workflow template definition, 
depending on where you want to paste the shape, and right-click.

4. From the pop-up menu, select Paste. The shape is pasted in the indicated 
workflow template definition. 

5. Modify the properties of the node as needed.

Printing a Template Definition

1. Use one of the following two methods to invoke the print facility:

l Right-click the workflow template definition in the folder tree of the Studio 
and select Print from the pop-up menu.

l Right-click anywhere in the drawing area of the workflow template 
definition diagram and select Print from the pop-up menu.

2. Select the type of information to print as follows:

l To print a text version of the workflow, select the Text tab and click Print.

l To print a graphical version of the workflow, select the Graphics tab and 
click Print. 

l To print a text and graphical version of the template definition, click Print 
All.

The Print dialog box is displayed. 
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3. Select the printer name. Then click either OK, to print the workflow, or Cancel, 
to cancel the print request.

Deleting Templates and Template 
Definitions

When deleting workflow template definitions, you have the following choice:

n You can delete a workflow template, in which case all workflow template 
definitions within the workflow template are deleted. 

n You can delete individual workflow template definitions. 

Deleting a Workflow Template

1. Right-click the workflow template name in the folder tree.

2. Choose Delete to display the Delete Template dialog box.

3. Click Yes to delete the specified workflow template and all its workflow template 
definitions, or click No to cancel the delete operation.

Deleting a Workflow Template Definition

1. Close the template definition.

2. Right-click the workflow template definition name in the folder tree, and choose 
Delete from the pop-up menu. The Delete Workflow dialog box asks you to 
confirm or cancel the delete.

3. Click Yes to delete the workflow template definition, or click No to cancel the 
delete operation.
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Exporting and Importing Workflow 
Packages

WebLogic Process Integrator provides the capability of exporting and importing 
workflow objects as Java Archive (JAR) files. This capability allows you to export and 
import templates, template definitions, business operations, business calendars, event 
key tables, and XML repository items. Organizations, users, and roles cannot be 
exported or imported. 

Exported packages can be marked as published packages. When a published package 
is imported, the objects in the package cannot be edited. In addition, you cannot create 
a new template definition in a published template. However, published templates and 
template definitions can be deleted.

You can also assign password protection to exported packages to prevent them from 
unauthorized import. 

Exporting Packages

1. Choose Tools→Export Package to display the Export: Select File dialog box. 

2. Specify the full pathname of the JAR file to which you want to export the 
package. If you know the full pathname, you can type it directly in the File: field. 
Alternatively, click Browse to navigate through the file system and select the 
desired file. 

3. Click Next. 

If you specified an existing JAR file that is not password protected, the Export: 
Select Components to Export dialog box is displayed.

If you specified an existing JAR file that is password protected, the Export: 
Enter Password dialog box is displayed. Enter the necessary password and click 
Next to display to display the Export: Select Components to Export dialog box, 
or click Back to specify an alternate file.

4. Complete the fields as described in the following table.
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In this field . . . Do this . . .

Select components Specify the components to be exported by selecting or 
deselecting the appropriate check boxes. The export feature does 
not enforce template definition integrity so you can deselect any 
object to exclude it from the exported package.

This field displays a tree-view of all the workflow objects in the 
system. If, in the Export: Select File dialog box, you selected an 
existing JAR file on your system in which to export the package, 
the items in the tree are prechecked, based on the contents of the 
selected JAR file. 

Note: Check boxes at the folder level have the following 
three states:

n Checked—This state indicates that all subobjects 
are selected.

n Unchecked—This state indicates that no 
subobjects are selected.

n Partially checked (checked with gray 
background)—This state indicates that at least 
one subobject is selected.

If you select a template definition to be exported, any 
subworkflows or business operations referenced by the template 
definition are automatically selected. However, business 
calendars, event keys, and XML entities are not automatically 
selected. Therefore, you must manually select these items if you 
want them to be included in the exported package.

If you export a template definition that specifies a due date for a 
task, and the due date is set using a business calendar, be sure to 
export the calendar along with the template definition. 

Similarly, if you export a template definition that uses the XSL 
Transform action, be sure to export the XML entities in the 
XML repository required by the XSL Transform action. The 
XML entities could be the XSLT template document or the 
XML input document.

Export File Leave as is. This field is populated with the full pathname of the 
JAR file you specified in step 2. If you want to change the 
content of this field, click Back to return to the Export: Select 
File dialog box, and enter the new information in the File field.
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5. Click Export to begin the export.

After the export operation is complete, a Review Export Summary report is 
displayed indicating if the export operation was successful.

6. Click Close to close the Review Export Summary dialog box, or Back to return to 
the previous screen.

Importing Packages

1. Choose Tools→Import Package to display the Import: Select File dialog box. 

2. Specify the full pathname of the JAR file to import. If you know the full 
pathname, you can type it directly in the File: field. Alternatively, click Browse to 
navigate through the file system and select the desired file. 

3. Click Next. 

If the package you want to import is not password protected, the Import: Select 
Components to Import dialog box is displayed.

If the package you want to import is password protected, the Import: Enter 
Password dialog box is displayed. Enter the necessary password and click Next 
to display the Import: Select Components to Import dialog box.

4. Complete the fields as described in the following table.

Published Package Select this check box to export the package as a published 
package. The objects of a published package are read-only and 
cannot be edited after they are imported to the target system.

Password Protect 1. Select this check box if you want to assign a password to 
protect the package from unauthorized import.  

2. Enter the password in the Password: and Confirm: fields. 

When you assign a password to a package, the user on the target 
system must specify this password before they can import the 
package.

In this field . . . Do this . . .
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5. Click Import to begin the import operation, or Cancel to cancel the operation.

Note: During  the import process, a warning is displayed if you are attempting to 
import an object with the same name as an object that already exists on 
your system. You can overwrite templates, business operations, and 
business calendars. You are not permitted to overwrite template 
definitions.

In this field . . . Do this . . .

Select components This field displays a tree-view of all the workflow objects in the 
JAR file to be imported.  All tree items are selected by default. 
Clear the check box for any object that you do not want to 
import. 

If you import a template definition that specifies a due date for a 
task, and the due date is set using a business calendar, be sure to 
import the calendar along with the template definition. 

Note: Since business calendars are referenced indirectly by 
organizations, users, and roles, the references are not 
maintained during the import process. After importing 
the package, be sure to reassign the necessary 
organizations, users, and roles to the business calendar.

Similarly, if you import a template definition that uses the XSL 
Transform action, be sure to import the XML entities in the 
XML repository required by the XSL Transform action. The 
XML entities could be the XSLT template document or the 
XML input document.

Import File Leave as is. This field is populated with the full pathname of the 
JAR file you specified in step 2.  If you want to change the 
content of this field, click the Back button to return to the 
previous dialog box, where you can enter new information in the 
File field.

Organization From the drop-down menu, select the organization to which the 
imported template definition should be assigned.

Activate after import Select this check box if you want the imported template 
definitions to be activated automatically after they are imported. 

Note: If a template definition has unresolved references to 
objects, it cannot be activated.
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If you are importing a template definition from a published package (that 
is, a package that you previously exported and marked as published), 
and a template does not exist on the target system, a published template 
is automatically created. If, however, you are importing a published 
template definition into an existing template, the existing template must 
also be published. You can not import a published template definition 
into an unpublished template.

Similarly, if you are importing a template definition from an unpublished 
package and a template does not exist on the target system, an 
unpublished template is automatically created. To import an unpublished 
template definition into an existing template, the existing template must 
also be unpublished. You can not import an unpublished template 
definition into an published template. 

After the import operation is complete, an Import Summary report is displayed. 
The report lists all the objects that were imported and any problems that were 
encountered during the import operation.

6. Click Close to close the Review Import Summary dialog box, or Back to return to 
the previous window.

Exporting a Template Definition

For compatibility with earlier versions of BEA WebLogic Process Integrator, you can 
export a workflow template definition, in XML format, from BEA WebLogic Process 
Integrator to any drive mapped in your computer. 

To export a workflow template definition:

1. In the folder tree, right-click the template definition to be exported.

2. Choose Export from the pop-up menu. 

The Save dialog box is displayed.

3. Select the drive and the directory in which you want to save the exported 
workflow template definition.

4. Click Save to export the template definition, or Cancel to cancel the operation.
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Importing a Template Definition

For compatibility with earlier versions of BEA WebLogic Process Integrator, you can 
import a workflow template definition (that was previously exported), in XML format, 
into BEA WebLogic Process Integrator to create a new workflow template definition. 

Note: Imported workflow template definitions are always marked as inactive. Before 
an imported workflow template definition can be instantiated, you must 
change the definition to active in the Template Definition dialog box. For 
details about making a template definition active, see “Setting Template 
Definition Properties” on page 7-5.

To import a workflow template definition:

1. In the BEA WebLogic Process Integrator folder tree, right-click the workflow 
template into which you will import the workflow template definition. 

Note: If a template does not exist, you must create one before you can import a 
template definition. For details about creating a template, see “Creating a 
New Template” on page 7-2.

From the pop-up menu, select Import Template Definition. The Save dialog box 
is displayed.

2. Select the current location of the exported workflow template definition file on 
your hard drive, and click Save.

Note: You cannot import a workflow template definition using a name that is 
different from the one that it was assigned when it was exported. If you 
attempt to do so, you will receive a warning message.

3. After the file is imported, an import confirmation dialog box is displayed and you 
are prompted to confirm the import. Click Yes to import the workflow template 
definition.

Note: In some cases, when you import a workflow, a warning message may be 
displayed. When a workflow template definition contains a Perform 
Business Operation or Start Workflow action, the action must be redefined 
when it is imported in a workflow. 
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CHAPTER

8 Defining Node 
Properties

The following sections describe how to define the properties for each of the nodes in 
the BEA WebLogic Process Integrator Studio:

n Defining Start Node Properties

n Assigning Workflow Variables

n Defining Task Node Properties

n Defining Decision Node Properties

n Defining Event Node Properties

n Defining Join Node Properties

n Defining Done Node Properties

Defining Start Node Properties

Every workflow has at least one start shape that indicates the beginning of the 
workflow. The first node after the start is the first node of the workflow to be activated. 
It can be a task, decision, or event.

To define a start node:

1. Display or add the start shape as described in “Adding Nodes to a Diagram” on 
page 7-13.
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2. Double-click the start shape to display the Start Properties dialog box. 
Alternatively, you can right-click the start shape and select Properties from the 
list.

3. The Description field, by default, contains the name Start. If you prefer, you can 
replace the default name with a unique, identifiable name.

4. Select a workflow triggering method:

l Timed—If you select this option, you need to define an exact date and time 
at which the workflow starts. For details about completing the additional 
fields displayed when you select this option, see “Defining a Timed Start 
Node” on page 8-3. 

l Manual—If you select this option, the workflow must be started manually, 
by an end user, from the BEA WebLogic Process Integrator Worklist. This 
type of start requires that the end user know the specific business criteria for 
starting the workflow. You might create a manual start node when you 
cannot create a trigger that captures all required conditions. No additional 
fields are displayed when you select this option. 

l Called—If you select this option, the workflow is called by another 
workflow using the Start Workflow action. For more information about this 
action, see “Start Workflow” on page 9-17.

l Event—If you select this option, complete the procedure in “Defining an 
Event-Triggered Start Node” on page 8-4.

5. Select the Variables tab (if it is not already selected). Use this field to assign 
workflow variables to be initialized at the start of your workflow. Click Add to 
display the Workflow Variable Assignment dialog box.

For details about assigning workflow variables, see “Assigning Workflow 
Variables” on page 8-7.

6. Select the Actions tab to display a list of all the actions to be performed when the 
start node is initiated. Click Add to display the Add Action dialog box. For 
further details about selecting actions, see Chapter 9, “Defining Actions.”

7. Select the Next tab to display a list of all task, decision, join, and done nodes in 
the current workflow. A start node can have one or more successors. Select the 
nodes to serve as the next activated nodes in the workflow when the start node is 
initiated.
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8. Select the Notes tab to enter any comments about the start node in the free-form 
text field.

9. Click OK to complete the operation, or click Cancel to cancel the operation.

Defining a Timed Start Node

1. Select the Timed option in the Start Properties dialog box.

2. Complete the fields as described in the following table.

In this field . . . Do this . . .

Start Date Expression Enter the expression that defines the start date for the workflow; 
you must use a date function, such as Date or DateAdd, in this 
expression. For instructions for entering an expression, see 
Chapter 10, “Creating Workflow Expressions.” 

Reschedule Optionally, you can enter values indicating when to reschedule 
the timed workflow. To enter a reschedule time:

1. Select the unit of time from the drop-down list. 

2. Enter a number to be associated with the unit of time in the 
field to the left of the drop-down list. For example, if you 
enter the number 4 and select Minutes from the drop-down 
list, the workflow will restart every four minutes.

Calendar Select the business calendar to use to evaluate the start date.

Start Organization Select a Start Organization from the drop-down list of 
organizations already defined within WebLogic Process 
Integrator. 

When the start node is an event or timed type, you must specify 
the organization for which the workflow instance will be started, 
because you can start the same workflow template definition for 
different organizations.
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Defining an Event-Triggered Start Node

1. Select the Event option in the Start Properties dialog box.

2. Complete the fields as described in the following table.

Use Workflow 
Expression

Select this check box if you want to define a Start Organization 
using an expression. When this box is checked, you must 
construct a workflow expression, therefore the A+B button 
appears to the right of the Start Organization field. The 
expression that you enter will be evaluated at run time and 
become the name of an organization. The expression can be 
either a string that specifies the organization (case sensitive) or 
an expression using information passed in the XML document.  

If you know the syntax of the expression you want to use, enter 
the expression directly in the Start Organization field. 
Alternatively, click the A+B button to display the Expression 
Builder dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow Expressions.” 

Variables tab Select the Variables tab (if it is not already selected). Use this 
field to assign workflow variables to be initialized at the start of 
your workflow. Click Add to display the Workflow Variable 
Assignment dialog box.

For details about assigning workflow variables, see “Assigning 
Workflow Variables” on page 8-7.

Actions tab Select the Actions tab to display a list of all the actions to be 
performed when the start node is initiated. Click Add to display 
the Add Action dialog box. For further details about selecting 
actions, see Chapter 9, “Defining Actions.”

Next tab Select the Next tab to display a list of all task, decision, join, and 
done nodes in the current workflow. A start node can have one 
or more successors. Select the nodes to serve as the next 
activated nodes in the workflow when the start node is initiated.

Notes tab Select the Notes tab to enter any comments about the start node 
in the free-form text field.

In this field . . . Do this . . .



Defining Start Node Properties

BEA WebLogic Process Integrator Studio Online Help 8-5

Note: If a plug-in is defined for the start node, this dialog box contains a 
drop-down list to access the functionality provided by the plug-in. For 
details about completing the fields for the plug-in start node, see the online 
help specific to the relevant plug-in. To access plug-in help, press the F1 
key (for context-sensitive plug-in help), or choose Help→Plugin Help 
from the main menu in the Studio and select the appropriate plug-in help 
from the menu.

In this field . . . Do this . . .

Document Type/Root 
Element

Enter the DOCTYPE or root element in the XML message that 
triggers the start of the workflow.

The DOCTYPE or root element you specify here must match the 
DOCTYPE or root element in the incoming XML message 
before BEA WebLogic Process Integrator starts the workflow.

Key Value Expression Define a key value for the XML document. You can enter a 
string that is the key value, or an expression that is evaluated at 
run time to produce the key value. 

The key value you specify here must match an element in the 
incoming XML message before BEA WebLogic Process 
Integrator starts the workflow. 

You also need to define the expression that locates the key value 
in the incoming XML message, so BEA WebLogic Process 
Integrator can compare it against the key value you specify in 
this field. For more information, see “Defining an Event Key” 
on page 8-15.

Condition (Optional) Define a condition that needs to be evaluated before 
the workflow can start. If the condition is true, BEA WebLogic 
Process Integrator starts the workflow.

If you know the syntax of the condition you want to use, you can 
enter it directly in the field. Alternatively, click the A+B button 
to display the Expression Builder dialog box. For more 
information about constructing expressions and conditions, see 
Chapter 10, “Creating Workflow Expressions.”
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Start Organization Select a Start Organization from the drop-down list of 
organizations already defined within WebLogic Process 
Integrator. When the start node is the Event type, you must 
specify the organization for which the workflow instance will be 
started, because you can start the same workflow template 
definition for different organizations.

Use Workflow 
Expression

Select this check box if you want to define the Start 
Organization using an expression. When this box is checked, 
you must construct a workflow expression, therefore the A+B 
button appears to the right of the Start Organization field. The 
expression that you enter will be evaluated at run time and 
become the name of an organization. The expression can be 
either a string that specifies the organization (case sensitive) or 
an expression using information passed in the XML document.  

If you know the syntax of the expression you want to use, enter 
the expression directly in the Start Organization field. 
Alternatively, click the A+B button to display the Expression 
Builder dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow Expressions.”

Variables tab Select the Variables tab (if it is not already selected) to specify 
the variables that should be initialized when the workflow starts. 
The XML message that starts the workflow can be parsed to 
extract information to be used in the initialization of workflow 
variables. 

Click Add to display the Workflow Variable Assignment dialog 
box.

For details about assigning workflow variables, see “Assigning 
Workflow Variables” on page 8-7.

Actions tab Select the Actions tab to display a list of all the actions to be 
performed when the start node is initiated. Click Add to display 
the Add Action dialog box. For further details about defining an 
action, see Chapter 9, “Defining Actions.”

Next tab Select the Next tab to display a list of all task, decision, join, and 
done nodes in the current workflow. A start node can have one 
or more successors. Select the nodes to serve as the next 
activated nodes in the workflow when the start node is 
instantiated.

In this field . . . Do this . . .
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Specifying Multiple Start Nodes

You can specify more than one start shape, if more than one simultaneous path through 
the workflow is to be started. For example, when you want two streams of work to start 
at the same time within a single workflow, you can define two starts within the 
workflow.

These two streams of work can be started simultaneously, if they have the same 
triggering event and are both marked as manual starts or timed starts set to the same 
time. Otherwise, the two streams can be started separately with each start being an 
alternate way of starting the workflow. If no start shape is specified, then no task 
activation can occur in the workflow.

You specify the triggering properties of a workflow in the start node. If a workflow 
contains multiple starts, each start can have its own triggering method and start 
independently. 

Specify the properties for each start node as described in “Defining Start Node 
Properties” on page 8-1.

Assigning Workflow Variables 

1. Access the Workflow Variable Assignment dialog box. This dialog box can be 
accessed from various properties and action dialog boxes in BEA WebLogic 
Process Integrator. For example, select the Variables tab in the Start Properties and 
Event Properties dialog box; then click Add.

2. Select the variable to which to assign the XML expression from the drop-down 
list. The variables in the drop-down list are those defined in the Variables 
Properties dialog box.

Notes tab Select the Notes tab to enter any comments about the start node 
in the free-form text field.

In this field . . . Do this . . .
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For details about the Variables Properties dialog box, see “Defining Workflow 
Variables” on page 7-8.

3. Enter a valid  expression to be assigned to the variable in the Event Expression 
field. For a timed start node, the XML expression can be:

l A string that you want to use as the value of the variable.

l An expression that is evaluated at run time to become the value of the 
variable.

For an event-triggered start node or a Send XML to Client action, the XML 
expression can be:

l The name of an element in the XML message, the value of which you want 
to assign to the selected variable.

l An XPath function that extracts a value from the XML message and assigns 
it to the selected variable.

If you know the syntax of the expression you want to use, enter the expression 
directly in the field. Alternatively, click the A+B button to display the 
Expression Builder dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow Expressions.”

4. Click OK to make the workflow variable assignment, or click Cancel to cancel 
the operation.

Defining Task Node Properties

1. Display or add the start shape as described in “Adding Nodes to a Diagram” on 
page 7-13.

2. Double-click the task shape or right-click the task in the folder tree. Then choose 
Properties to display the Task Properties dialog box.

3. Complete the fields as described in the following table. Then click either OK, to 
define the node, or Cancel, to cancel the operation.
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In this field . . . Do this . . .

Task Name Enter a meaningful name for the task.

Priority Select Low, Medium, or High priority from the drop-down list. The initial default 
value is Medium.

Actions Each task node progresses through four different states: created, activated, executed, 
and marked done. Progress through these states is not automatic. Each state is 
activated by some event. For each state, you can specify a list of actions that are 
performed when the task reaches that state.  

Specify actions for each state as follows:

n Created—A task is created when a workflow is instantiated. Define actions under 
the Created tab that you want executed as soon the workflow is instantiated.

n Activated—A task is activated when the previous node has completed its 
processing. It remains activated until the task is marked done. Define actions 
under the Activated tab that you want executed automatically when the task is 
activated.

n Executed—A task is executed by  when a user manually executes the task using 
the Worklist application, using the Execute Task action, or programmatically, 
using the BEA WebLogic Process Integrator APIs. Define actions under the 
Executed tab that you want executed by an end user using the Worklist 
application, or by another client application using the BEA WebLogic Process 
Integrator APIs.

Note: If a task is not assigned to a user or role, and is not executed 
programmatically, the actions defined under the Executed tab will not be 
executed at run time.

n MarkedDone—A task is marked done using the Mark Task as Done action, or 
programmatically using the BEA WebLogic Process Integrator APIs. Define 
actions under the Marked Done tab that you want executed when the task is 
marked done.

For a description of how to specify actions, see Chapter 9, “Defining Actions.”
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Viewing Task Usage

1. Right-click the task node in either the workflow diagram or the folder tree. Then 
select Usage from the pop-up menu. 

Properties This section contains four fields that provide additional information about the task. 
Select one of the following tabs:

n Next—This field displays a list of all nodes in the current workflow. When this 
task is marked done, the selected items are activated next in the flow. If you have 
defined a sequence for the shapes on the workflow diagram using connector 
lines, the check box next to any successor shape is selected. Place a check mark 
beside any other shape you want to execute after this task is complete; a 
connector line is automatically drawn on the workflow diagram. You can also 
create a connection between a task shape and a subsequent shape by clicking the 
Connector shape on the drawing area toolbar, clicking in the drawing area to drop 
it, and then moving its end points to make the connections.

n Permissions—This field specifies how a task instance can be modified or 
processed, once the workflow is started. Select a permission to activate it. The 
permissions can be selected in any combination. Five different permissions are 
maintained for each task:

Mark done without executing—Allows users to mark the task as having been 
done without actually executing it.

Re-execute if marked done—Allows users to re-execute the task when it is 
already marked as done. 

Unmark if marked done—Allows users to change the status of the task back to 
not done when the task is marked as done. (If a user marks a completed task as 
not done, the task status is set to Active, but the effects of any actions that 
have been executed are not reversed.) 

Modifiable—Allows users to change the properties of an existing task using 
the Worklist.

Re-assignable—Allows users to reassign the task to another user. 

n Task Notes—Enter notes or comments about the task in this free-form text field.

n Action Notes—This is a read-only text field showing the defined notes for the 
action selected on the left-hand side of the dialog box.

In this field . . . Do this . . .
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The Task Usage dialog box is displayed. This dialog box lists all the nodes in 
the workflow where the task is used. 

2. Expand each node to display a list of the actions assigned to the task.

3. Click the Update or Delete button to make the changes you want.

4. Click OK to complete the operation.

Defining Decision Node Properties

The workflow can use any number of decision shapes. Each decision shape contains a 
condition that is evaluated when a transition to that decision node occurs. The result is 
either True or False, with subsequent flow of control passed to the subsequent task, 
decision, event, and join or done nodes. Additionally, it is possible to specify actions 
to be executed on both a True and a False evaluation of the condition. (If the condition 
is verified, it is True. If it is not, it is False.)

To define a decision:

1. Add or view a decision shape as described in “Adding Nodes to a Diagram” on 
page 7-13.

2. Double-click the decision shape or right-click it in the folder tree. Then select 
Properties to display the Decision Properties dialog box.

3. Complete the fields as described in the following table and click OK to define the 
node or Cancel to cancel the operation.

In this field . . . Do this . . .

Condition Specify the conditional expression to be evaluated at run time. When the decision is 
activated in a running workflow (that is, when a transition is made to the decision 
shape), this conditional expression is evaluated. 

If you know the syntax of the condition you want to use, you can enter it directly in 
the field. Alternatively, click the A+B button to display the Expression Builder 
dialog box. For more information about constructing expressions and conditions, see 
Chapter 10, “Creating Workflow Expressions.”
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Actions A tabbed display showing the list of actions to be executed if the specified condition 
is evaluated and the result is either False or True. The tab that appears foremost 
indicates which of the two lists (False or True) is currently displayed. See Chapter 9, 
“Defining Actions,” for a description of how to specify actions.

n False—Actions defined in this tab are executed if the condition evaluates to false 
(that is, if it is not verified).

n True—Actions defined in this tab are executed if the condition evaluates to true 
(that is, if it is verified).

Properties This field contains four tabs: Next True, Next False, Decision Notes, and Action 
Notes. Select the appropriate tab to display or add information about the node.

n Next True—This field displays a list of all nodes in the current workflow. On a 
True evaluation of the specified decision condition, the indicated items are 
activated next in the flow. If you have defined a sequence for the shapes in the 
workflow diagram using connector lines, a check mark is displayed next to any 
successor shapes. Place a check mark beside any other shape you want to execute 
after a True evaluation of this decision. A connector line is automatically drawn 
on the workflow diagram. You can also create a True connection between a 
decision shape and a subsequent node by clicking the Connector shape on the 
drawing area toolbar, clicking in the drawing area to drop it, and then moving its 
end points to make the connections.

n Next False—This field displays a list of all nodes in the current workflow. On a 
False evaluation of the specified decision condition, the indicated items are 
activated next in the flow. If you have defined a sequence for the shapes in the 
workflow diagram using connector lines, a check mark is displayed next to any 
successor shapes. Place a check mark beside any other shape you want to execute 
after a False evaluation of this decision. A connector line is automatically drawn 
on the workflow diagram. A False connection from the decision shape to a 
subsequent node can also be created by clicking the Connector shape on the 
drawing area toolbar, clicking in the drawing area to drop it, and then moving its 
end points to make the connections.

n Decision Notes—Enter notes or comments about the Decision node in this 
free-form text field.

n Action Notes—This field is a read-only text field showing the defined notes for 
the action selected on the left-hand side of the dialog box.

In this field . . . Do this . . .
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Defining Event Node Properties

An event node represents a wait state that is activated by the receipt of an XML 
message. The XML message can come from another workflow or from an external 
source, such as another application. For further information about events and how they 
are triggered, see Appendix A, “Understanding Event-Driven Processing,” in Using 
the BEA WebLogic Process Integrator Studio.

To define a WebLogic Process Integrator notification event:

1. Display or add an event node as described in “Adding Nodes to a Diagram” on page 
7-13.

2. Double-click the event node or right-click it in the folder tree. Then select 
Properties to display the Event Properties dialog box.

3. Complete the fields as described in the following table, and click OK to define 
the node, or Cancel to cancel the operation.

In this field . . . Do this . . .

Description Enter a meaningful name for the event you will define. The name 
will be displayed in the workflow drawing area.

Type Select a type of event from the drop-down list. For an XML 
message, select XML Event.

Note: If a plug-in is defined for the event node, the  
drop-down list contains a list of the available events 
defined by the plug-in.  For information about 
completing the fields for the selected plug-in event, see 
the online help specific to the relevant plug-in. To 
access plug-in help, press the F1 key (for 
context-sensitive plug-in help), or choose 
Help→Plugin Help from the main menu in the Studio 
and select the appropriate plug-in help from the menu.
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Document Type/Root 
Element

Enter the DOCTYPE or root element in the XML message that 
will trigger the event.

The DOCTYPE or root element you specify here must match the 
DOCTYPE or root element in the incoming XML message 
before BEA WebLogic Process Integrator will trigger the event.

Key Value Expression (Optional) Define a key value for the XML message. You can 
enter a string that is the key value, or an expression that will be 
evaluated at run time to produce the key value.

The key value you specify here must match an element in the 
incoming XML message before BEA WebLogic Process 
Integrator will trigger the event.

You also need to define the expression that locates the key value 
in the incoming XML message, so BEA WebLogic Process 
Integrator can compare it against the key value you specify in 
this field. For more information, see “Defining an Event Key” on 
page 8-15.

Condition (Optional) Define a condition that needs to be evaluated before 
the workflow can start. If the condition is true, BEA WebLogic 
Process Integrator will trigger the event.

If you know the syntax of the condition you want to use, you can 
enter it directly in the field. Alternatively, click the A+B button 
to display the Expression Builder dialog box. For more 
information about constructing expressions and conditions, see 
Chapter 10, “Creating Workflow Expressions.”

Variables tab Select the Variables tab (if it is not already selected) to assign 
values to an XML expression. The XML message that triggers 
the workflow can be parsed to extract information to be used in 
the initialization of workflow variables.  

Click Add to display the Workflow Variable Assignment dialog 
box. For details about assigning workflow variables, see 
“Assigning Workflow Variables” on page 8-7.

Actions tab 1. Select the Actions tab to display the list of all actions to be 
performed upon the triggering of the event.

2. Click Add to display the Add Action dialog box. For further 
details about defining actions, see Chapter 9, “Defining 
Actions.”

In this field . . . Do this . . .
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Defining an Event Key

An event key is a value that must match an element in the incoming XML document 
before BEA WebLogic Process Integrator starts the workflow or triggers an Event 
node. The key value can be any element immediately under the root element of the 
incoming XML message. You specify the key value in the Start or Event properties 
dialog box. For details about events, see Appendix A, “Understanding Event-Driven 
Processing,” in Using the BEA WebLogic Process Integrator Studio.

To use an event key, you need to do the following:

n Specify the key value in the Start or Event Properties dialog box. For details, see 
“Defining an Event-Triggered Start Node” on page 8-4 and “Defining Event 
Node Properties” on page 8-13.

n Define the expression that locates the key value in the incoming XML message, 
so BEA WebLogic Process Integrator can compare it against the key value you 
specify in the Start or Event Properties dialog box.

To specify an event key:

1. From the BEA WebLogic Process Integrator Configuration menu, select Events to 
display the Event Key Expressions dialog box.

This dialog box displays a list of all the event key expressions defined in the 
workflow.

2. Click Add to display the Define Event Key Expression dialog box.

3. In the Content Type field, select text/xml for an XML message.

Next tab 1. Select the Next tab to display a list of all task, decision, join, 
and done nodes in the current workflow. 

2. Select the node to succeed the event. An event can have one 
or more successors. The indicated items in this list will be 
the next activated in the flow after the event is triggered.

Notes tab Select the Notes tab to enter any comments about the start node 
in the free-form text field.

In this field . . . Do this . . .
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4. In the Event Descriptor field, enter the DOCTYPE or root element you specified 
in the Start or Event Properties dialog box.

5. In the Expression field, enter the expression that identifies the location of the key 
value in the incoming XML message.

Note: Expressions are built using WebLogic Process Integrator expression 
syntax and typically use the syntax of the XPath function to extract values 
out of XML documents. If you know the syntax of the expression you want 
to use, you can type the expression directly in the field. Alternatively, click 
the A+B button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, “Creating 
Workflow Expressions.”

6. Click OK on the Define Event Key Expression dialog box. 

The event key is stored in an event key table maintained by BEA WebLogic 
Process Integrator, and is displayed in the Event Key Expressions dialog box.

7. Click Close to close the Event Key Expressions dialog box.

Viewing Event Usage

1. Right-click the event node in the workflow diagram or in the folder tree. Then 
select Usage from the pop-up menu. 

The Event Usage dialog box is displayed. This dialog box lists all the nodes in 
the workflow where the event is used. 

2. Expand each node to display a list of the actions assigned to the event.

3. Click the Update or Delete button to make the changes you want.

4. Click OK to complete the operation.
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Defining Join Node Properties

1. Display or add a join node as described in “Adding Nodes to a Diagram” on page 
7-13.

2. Double-click the join shape or right-click it in the folder tree. Then select 
Properties to display the Join Properties dialog box.

3. Complete the fields as shown in the following table. Then click either OK, to 
define the node, or Cancel, to cancel the operation.

Defining Done Node Properties

A done shape represents the point within the workflow at which the process completes. 
Once a done node is reached in the workflow, the running instance of the workflow is 
marked done, regardless of whether all the done nodes have been reached or not.

You can specify any number of done nodes in a workflow. If a workflow can exit from 
various points, you have the option of creating separate done nodes wherever they are 
needed.

To define a done:

In this field . . . Do this . . .

And/Or option buttons Select the appropriate option button to indicate whether the join 
is an AND join or an OR join.

Next This field displays a list of all nodes in the current workflow. A 
join can have one or more successors. 

Select items in this list to activate them in the flow after the join 
is satisfied.

Notes Optionally, enter any notes about the node in the free-form text 
field.
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1. Add or view a done shape as described in “Adding Nodes to a Diagram” on page 
7-13.

2. Double-click the done shape or right-click it in the folder tree. Then select 
Properties to display the Done Properties dialog box.

Note: If a plug-in is defined for the done node, this dialog box contains a 
selection to access the functionality provided by the plug-in. For details 
about completing the fields for the selected plug-in Done node, see the 
online help specific to the relevant plug-in. To access plug-in help, press 
the F1 key (for context-sensitive plug-in help), or choose Help→Plugin 
Help from the main menu in the Studio and select the appropriate plug-in 
help from the menu.

3. Complete the fields as described in the following table. Then click either OK, to 
define the node, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Actions This field displays a list of all the actions to be performed when 
the done node is reached. 

To add additional actions, click Add; the Add Action dialog box 
is displayed. For details about adding actions, see Chapter 9, 
“Defining Actions.”

Notes (Optional) Enter any notes about the node in the free-form text 
field.
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CHAPTER

9 Defining Actions

The following sections can help you define and work with actions in the BEA 
WebLogic Process Integrator Studio:

n What Is an Action?

n Adding or Updating an Action

n Copying Actions Within Nodes

n Copying Actions Between Nodes

n Deleting an Action

n Changing the Sequence of Actions

n Defining Task Actions

n Defining Workflow Actions

n Defining Integration Actions

n Defining Exception-Handling Actions

n Defining Miscellaneous Actions
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What Is an Action?

An action is a basic unit of work that is performed by BEA WebLogic Process 
Integrator.  It can be as simple as assigning a task to a user or as complicated as sending 
XML messages or invoking Enterprise JavaBean (EJB) methods. Actions are the 
primitive building blocks of a workflow: they define the actual behavior of the 
workflow. Numerous actions are shipped with BEA WebLogic Process Integrator.

What Are the Categories of Actions?

Actions are organized into the following categories:

n Task Actions

n Workflow Actions

n Integration Actions

n Error Handling Actions 

n Miscellaneous Actions

Where Can I Use Actions?

You can place actions in various locations in a workflow. The most common location 
is in a Task. Actions can also be placed in decisions, starts, events, and dones. An 
action is executed when the appropriate node is activated. 

You can also place actions within other actions. Such actions are executed when the 
conditions specific to that action are met. 
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Plug-In Actions

Plug-ins can add plug-in-defined actions or action categories to the standard BEA 
WebLogic Process Integrator action tree displayed in the Add Action dialog box. The 
action tree displayed consists of both the BEA WebLogic Process Integrator actions 
and the plug-in-defined actions. 

To complete the fields in a plug-in action dialog box, see the online help specific to the 
relevant plug-in. To access plug-in help, press the F1 key (for context-sensitive plug-in 
help), or choose Help→Plugin Help from the main menu in the Studio and select the 
appropriate plug-in help from the menu.

Adding or Updating an Action

You add and update actions in the Task Properties, Decision Properties, Event 
Properties, and Start Properties dialog boxes. Each dialog box includes an area specific 
to action maintenance.

To add or update an action:

1. Double-click the Task, Event, Decision, Start, or Done for which you want to add 
or update an action. The Properties dialog box appears.

2. In the properties dialog box, select the appropriate action tab and click Add or 
Update to display the Add Action dialog box.

3. Double-click an action type folder to expand it, select an action, and click OK.

A dialog box specific to the selected action is displayed.

4. Complete the fields in the dialog box and click OK.

For details about completing the information in specific action dialog boxes, see 
the following sections:

l  “Defining Task Actions” on page 9-6  

l “Defining Workflow Actions” on page 9-16

l “Defining Integration Actions” on page 9-24
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l “Defining Exception-Handling Actions” on page 9-35

l “Defining Miscellaneous Actions” on page 9-39 

The action is updated or added to the Activated actions tab in the Properties 
dialog box.

Copying Actions Within Nodes

1. From the drawing area, right-click the node shape containing the defined action 
that you will copy. 

2. Select Properties from the pop-up menu to display the Properties dialog box for 
that node shape.

3. In the Actions portion of the window, select the appropriate tab containing the 
action to be copied: Created, Activated, Executed, or MarkedDone.

4. Right-click the defined action that you will copy, and select Copy from the 
pop-up menu.

5. In the Actions portion of the window, select the appropriate tab where you will 
paste the action: Created, Activated, Executed, or MarkedDone.

6. Right-click anywhere in the Actions portion of the window.

7. Select Paste from the pop-up menu.

8. Depending on the copied action, a dialog box that corresponds to the copied 
action is displayed.

9. Make changes, if needed, to the action definition, and click OK. The action is 
copied into the Actions portion of the window.
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Copying Actions Between Nodes

1. From the drawing area, right-click the node shape containing the defined action 
that you will copy. 

2. Select Properties from the pop-up menu to display the Properties dialog box for 
that node shape.

3. In the Actions portion of the window, select the appropriate tab containing the 
action to be copied: Created, Activated, Executed, or MarkedDone.

4. Right-click the defined action that you will copy, and select Copy from the 
pop-up menu.

5. From the drawing area, right-click the node shape to which you will paste the 
defined action.

6. Select Properties from the pop-up menu to display the Properties dialog box for 
that node shape.

7. In the Actions portion of the window, select the appropriate tab to which the 
action is to be pasted: Created, Activated, Executed, or MarkedDone.

8. Right-click anywhere in the Actions portion of the screen, and select Paste from 
the pop-up menu.

9. Depending on the pasted action, a dialog box appears that corresponds to the 
action.

10. Make changes, if needed, to the action definition, and click OK. The action is 
pasted into the Actions portion of the window.

Deleting an Action

1. In the workflow diagram, double-click the shape that contains the action you want 
to delete.
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2. Select the desired action in the Actions section of the Properties dialog box, and 
click the Delete button.

A confirmation dialog box is displayed to prevent accidental deletions.

3. Click Yes to delete the action or No to cancel the delete operation.

When an action is deleted, all references to the action are removed. The action is 
removed from all instances of the workflow, including those currently running.

Changing the Sequence of Actions

Actions are displayed in the sequence in which they are executed. To change the 
sequence of actions:

1. Select an action from the list in the Properties dialog box.

2. Press the up or down arrow to move its position in the list.

Defining Task Actions

This section describes how to use the following task actions:

n Mark Task as Done

n Unmark Task Done

n Set Task Due Date

n Assign Task to User

n Assign Task to Role

n Assign Task Using Routing Table

n Unassign Task

n Set Task Comment
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n Set Task Priority

n Execute Task

Mark Task as Done

Use this action to set the completion date of a specified task to the current time and to 
mark the task as done.

To mark a task as done:

1. In the node Properties dialog box, select the tab that indicates the stage at which 
you want the task to be marked as done: Created, Activated, Executed, or 
MarkedDone. 

2. Click Add to display the Add Action dialog box.

3. Expand the Task Actions list and select the Mark Task as Done action.

4. Click OK to display the Mark Task as Done dialog box.

5. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Unmark Task Done

Use this action to clear the completion date of a specified task and mark the task as not 
done.

To unmark a task as done:

In this field . . . Do this . . .

Task to mark as done This field displays all the tasks in the workflow. 

Select the task to be marked done when the action is executed. 
Only one task at a time can be marked done.

Notes (Optional) Enter any  notes about the action in this free-form text 
field.
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1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Unmark Task Done action.

3. Click OK to display the Unmark Task Done dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Set Task Due Date

Use this action to set the due date for a specified task. The date can be determined by 
specifying an interval (expressed in minutes, hours, days, weeks, or months) calculated 
from the time when the action is executed. Alternatively, the due date can be based on 
an expression. You can also specify subactions to be performed when the task becomes 
overdue.

To set a task due date:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list, select the Set Task Due Date action, and click OK 
to display the Set Task Due Date dialog box.

3. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Task to unmark as done This field displays all the tasks in the workflow. 

Select the task that is to be unmarked as done when the action is 
executed. Only one task at a time can be unmarked done.

Notes (Optional) Enter any  notes about the action in this free-form text 
field.
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Assign Task to User

Use this action to assign a specified task to an individual user or to a user in a role. 

To assign a task to a user:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

In this field . . . Do this . . .

Task to set due date for This field displays all the tasks in the workflow. 

Select the task for which you want to set the due date when the 
action is executed. You can select only one task at a time.

Due Date tab 1. Enter an expression in the Set to Expression field. You can 
set the due date to be any point in time after the action is 
executed, or based on the evaluation of an expression.

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”

2. If the due date is set using business hours or business days, 
specify a business calendar using the drop-down list in the 
Business Calendar field. The drop-down list consists of a list 
of defined business calendars, along with two additional 
choices: For Organization and For Assignee. The default is 
the calendar specified for the organization but it can be 
changed to any other calendar. The specified calendar will 
be used in calculating the actual due time.

Overdue Actions tab Use this field to specify optional subactions to be performed  
when the due date is reached. 

1. Click Add to display the Add Action dialog box.

2. Specify actions as desired.

Notes tab (Optional) Click this tab and enter any notes about the action in 
the free-form text field.



9 Defining Actions

9-10 BEA WebLogic Process Integrator Studio Online Help

2. Expand the Task Actions list and select the Assign Task to User action. 

3. Click OK to display the Assign Task to User dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Assign Task to Role

Use this action to assign a task to a role, either directly, by assigning the task to a 
constant role, or by taking the value of a workflow expression at run time.

In this field . . . Do this . . .

Task to assign This field displays all the tasks in the workflow. 

Select the task that is to be assigned when the action is 
executed. Only one task at a time can be selected.

User When the Use workflow expression and Assign to role member 
boxes are unchecked, a list of available users is provided in the 
User drop-down list.

Select a user to assign to the task from the drop-down list.

Use workflow expression Check this box to indicate that the assignee must be specified 
as the value of a workflow expression to be taken at run time. 
When this box is checked, you must construct a workflow 
expression to reference the user or role. Therefore, the A+B 
button appears to the right of the User field.

If you know the syntax of the expression you want to use, enter 
the expression directly in the User field. Alternatively, click the 
A+B button to display the Expression Builder dialog box. For 
more information about constructing expressions, see 
Chapter 10, “Creating Workflow Expressions.”

Assign to Role Member Check this box to assign the task to a role member. 

When this box is checked, the User in Role drop-down list 
shows a list of roles.  Select the desired role from the list.

Notes (Optional) Enter any notes about the action in this free-form 
text field.
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To assign a task to a role:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Assign Task to Role action. 

3. Click OK to display the Assign Task to Role dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Task to assign This field displays all the tasks in the workflow. 

Select the task that is to be assigned when the action is 
executed. Only one task at a time can be selected.

Role Select a role to assign to the task from the drop-down list. 

When the Use workflow expression box is checked, you must 
create a workflow expression to reference the role.

Use Workflow Expression Check this box to indicate that the assignee must be specified 
as the value of a workflow expression to be taken at run time. 
When this box is checked, you must construct a workflow 
expression. Therefore, the A+B button appears to the right of 
the Role field.

If you know the syntax of the expression you want to use, enter 
the expression directly in the Role field. Alternatively, click the 
A+B button to display the Expression Builder dialog box. For 
more information about constructing expressions, see 
Chapter 10, “Creating Workflow Expressions.”

Notes (Optional) Enter any notes about the action in this free-form 
text field.
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Assign Task Using Routing Table

Use the Assign Task Using Routing Table action to specify rules for determining 
dynamically, that is, at run time, where a task should be assigned. A routing table 
consists of a sequence of one or more routing conditions. A routing condition specifies 
a potential assignee (user or role) for the task, together with a specification of the 
conditions under which the assignment should be made. 

To assign a task using a routing table:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Assign Task Using Routing Table 
action. 

3. Click OK to display the Assign Task Using Routing Table dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Task to assign This field displays all the tasks in the workflow. 

Select the task that is to be assigned when the action is 
executed. Only one task at a time can be selected.
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Unassign Task

Use this action to remove the current task assignment. After this action is performed, 
the task is no longer assigned to the original user or role.

To unassign a task:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Unassign Task action.

3. Click OK to display the Unassign Task dialog box.

Routing Table This field contains a table of conditions and assignees. You can 
add, update, or delete routing conditions in this field. 

To add or update a routing condition:

1. Click Add or Update to display the Define Routing 
Condition dialog box.

2. Enter a valid workflow conditional expression that yields a 
logical result (True or False) in the Condition field.

If you know the syntax of the expression you want to use, 
enter the expression directly in the Condition field. 
Alternatively, click the A+B button to display the 
Expression Builder dialog box. For more information 
about constructing expressions, see Chapter 10, “Creating 
Workflow Expressions.”

3. Select a User, User in Role, or Role from the Assign To 
drop-down list.

The contents of the Assign To list changes based on the 
User, User in Role, or Role option button that is selected.

4. Click OK, to add or update the condition, or Cancel, to 
cancel the operation.

Use the Up/Down arrows to change the sequence of conditions.

Notes (Optional) Enter any notes about the action in this free-form 
text field.

In this field . . . Do this . . .
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4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Set Task Comment

Use this action to display a free-form text message to the user at run time when the 
action is executed. The text is typically explanatory, or it requests the user to perform 
manual actions for which the workflow does not provide further automated support. 

To set a task comment:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Set Task Comment action.

3. Click OK to display the Set Task Comment dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Task to unassign This field displays all the tasks in the workflow. 

Select the task that is to be unassigned when the action is 
executed. Only one task at a time can be unmarked done.

Notes (Optional) Enter any notes about the action in this free-form text 
field.

In this field . . . Do this . . .

Task to set comment for This field displays all the tasks in the workflow. 

Select the task for which you want a comment set when the 
action is executed. Only one task at a time can be unmarked 
done.
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Set Task Priority

Use this action to set a task priority to Low, Medium, or High.

To set a task priority:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Set Task Priority action.

3. Click OK to display the Set Task Priority dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Comment Enter a valid workflow expression to be evaluated at run time for 
the task comment.

If you know the syntax of the expression you want to use, enter 
the expression directly in the Comment field. Alternatively, 
click the A+B button to display the Expression Builder dialog 
box. For more information about constructing expressions, see 
Chapter 10, “Creating Workflow Expressions.”

Notes (Optional) Enter any notes about the action in this free-form text 
field.

In this field . . . Do this . . .

In this field . . . Do this . . .

Task to set priority for This field displays all the tasks in the workflow. Select the task 
to which to assign a priority. Only one task at a time can be 
selected.

Priority Use the Priority drop-down list to select the priority for the task.

Notes (Optional) Enter any notes about the action in this free-form text 
field.
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Execute Task

Use this action to execute a selected task.

To execute a task:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Task Actions list and select the Execute Task action.

3. Click OK to display the Execute Task dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Defining Workflow Actions

This section describes how to use the following workflow actions:

n Mark Workflow as Done

n Abort Workflow

n Start Workflow

n Set Workflow Variable

n Set Workflow Comment

In this field . . . Do this . . .

Task to execute This field displays all the tasks in the workflow. 

Select the task to be executed. Only one task at a time can be 
selected.

Notes (Optional) Enter any notes about the action in this free-form text 
field.
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Mark Workflow as Done

Use this action to mark the workflow as done; it accomplishes the same result that is 
achieved when a workflow reaches a Done node.

To mark a workflow as done:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Workflow Actions list and select the Mark Workflow as Done action.

3. Click OK to display the Mark Workflow as Done dialog box.

4. (Optional) Enter any notes about the action in the free-form text Notes field.

5. Click OK to complete the operation, or Cancel, to cancel the operation.

Abort Workflow

Use the Abort Workflow action to permanently stop a workflow that is currently in 
process. 

To use the Abort Workflow action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Workflow Actions list and select the Abort Workflow action.

3. Click OK to display the Abort Workflow dialog box.

4. (Optional) Enter any notes about the action in the free-form Notes field.

5. Click OK to complete the operation, or Cancel, to cancel the operation.

Start Workflow

Use this action to initiate a subworkflow. The workflow being started is sometimes 
referred to as a subworkflow or a called workflow. The workflow that starts the 
subworkflow is called the calling workflow.
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The started workflow can be tracked with a variable reference. When it completes, you 
can perform an optional set of subactions.

To use the Start Workflow action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Workflow Actions list and select the Start Workflow action.

3. Click OK to display the Start Workflow dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Workflow to Start This field displays all the workflow templates defined in the 
system. 

Select the workflow template to start when the action is 
executed. Only one workflow template can be started at a time.

Start in Organization Select one of the following options:

n Select the Current Organization option to start the workflow 
for the current organization (the organization selected from 
the Organization drop-down list on the BEA WebLogic 
Process Integrator main window).

n Select the Expression option to start the workflow for an 
organization that is specified by the value of a workflow 
expression. If you select this option, you must construct a 
workflow expression.

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”
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Reference via This drop-down list contains a list of workflow variables 
available for the current workflow. To assign the workflow ID 
of the started workflow to a variable, select the desired variable 
from the drop-down list. 

The selected variable can be used in expressions from within the 
calling workflow to retrieve variables from the newly started 
workflow. For example, NewWF.Name retrieves the value of 
the Name variable from the new workflow referenced via the 
NewWF variable.

Parameters tab This field displays a list of variables within the target workflow, 
allowing the initial values to be set from an explicitly defined 
variable in the calling workflow.

To set a value for a parameter to be passed:

1. Click Add or Update to display the Set Parameter dialog 
box.

2. In the Parameter field, enter the name of the variable as it is 
specified in the called workflow. This variable must be 
defined as an input variable in the called workflow.

3. In the Expression field, enter the value to pass as an 
expression. 

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”

4. Click OK to set the parameter or Cancel to cancel the 
operation.

In this field . . . Do this . . .
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Set Workflow Variable

Use the Set Workflow Variable action to:

n Assign a value to a workflow variable you defined using the Variables 
Properties dialog box. For details about defining variables, see “Defining 
Workflow Variables” on page 7-8. The value you assign to the variable can be an 
expression or a literal.

n Evaluate the literal value or the specified expression and assign the result to a 
workflow variable when the action is executed.

Results tab This field displays variables for the selected workflow that have 
been declared as output variables at definition time. You can 
save values from these variable in the variables defined for this 
workflow.

To set a variable to receive results:

1. Click Add or Update to display the Set Variable from Result 
dialog box.

2. The Variable drop-down list contains a list of  variables for 
the current workflow. Select the variable to receive a result 
value.

3. Enter the name of the variable in the called workflow from 
which you want to pull the results. The variable must be 
defined as an output variable in the called workflow.

4. Click OK to set the variable or Cancel to cancel the 
operation.

Actions tab Use this field to specify optional subactions to be performed 
when the called workflow is completed. It can be used to mark 
the current task as done.

1. Click Add to display the Add Action dialog box.

2. Specify actions as desired.

Notes tab (Optional) Click this tab and enter any notes about the action in 
the free-form text field.

In this field . . . Do this . . .
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n Compose an XML document and store the content in an XML-type variable. 
XML-type variables can be sent as internal or external XML messages using the  
Post XML Event action. 

For more information about the Post XML Event action, see “Post XML Event” 
on page 9-24.

To set a workflow variable:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Workflow Actions list and select the Set Workflow Variable action.

3. Click OK to display the Set Workflow Variable dialog box.

4. Complete the fields as described in the following table. Then click OK to set the 
workflow variable or Cancel to cancel the operation.

In this field . . . Do this . . .

Variable to be set From the drop-down list, select an existing, defined variable to 
which you will assign a value.

From Expression Select this option to define the variable by constructing an 
expression or entering a literal in double quotes (for example, a 
string-type variable).

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

By Composing Select this option to indicate that you want to define an XML or 
string type variable in which to store the XML document. 

Next, create an XML structure containing elements and 
attributes. For details about composing the XML structure, see 
“Composing XML Documents” on page 9-22.

Note: An XML document that is stored in a string variable 
will first be converted to a string.

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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Composing XML Documents

An XML editor is displayed in the following dialog boxes in the Studio:

n Set Workflow Variable

n Post XML Event

n Send XML to Client

n Invoke Exception Handler

Use the instructions provided in the following table to compose XML documents in 
each of these dialog boxes using the XML editor.

To . . . Perform This Action . . .

Retrieve an existing XML 
document for editing

Click the Import button to open the XML Finder dialog box. 
Use the XML Finder to retrieve an existing XML document 
that you can edit. For details about the XML Finder, see 
Chapter 12, “Using the XML Finder to Access XML Entities.”

Add the first element of the 
XML message

Click the Add Child button.

Change the default element 
name

Select the element; then double-click the element. The element 
name becomes an entry field. Change the element name as 
appropriate; then press Enter.

To cancel the change, press Esc.

Add a sub-element to an 
element

Select the element, then click the Add Child button.

Add an element at the same 
level as another element

Select the element, then click the Add Sibling button.

Add an attribute to an 
element

Select the element, then click the Add Attribute button.

Change the default attribute 
name

Select the attribute; then double-click the attribute. The 
attribute name becomes an entry field. Change the attribute 
name as appropriate; then press Enter.

To cancel the change, press Esc.
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Set Workflow Comment

Use this action to specify a valid workflow expression to be displayed to the user at run 
time when the action is executed.  

To set a workflow comment:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Workflow Actions list and select the Set Workflow Comment action.

3. Click OK to display the Set Workflow Comment dialog box.

Change the order of the 
elements

Select the element you want to move, and use the arrow buttons 
as follows:

n To move the element up or down a level, click the Move 
Left or Move Right arrow. 

n To move the element up or down within a level, click the 
Move Up or Move Down arrow 

Change the content of a leaf 
element or attribute

In the right panel, double-click the line next to the element or 
attribute for which you want to change the content. The line 
becomes an entry field. Type the content.

To cancel the change, press Esc.

Note: The syntax for the content of a leaf element or an 
attribute must follow the same rules that are used for 
workflow expressions. For example, string literals 
must be enclosed in single or double quotes. If the 
syntax is incorrect, a red X appears next to the entry. 
For details about defining workflow expressions, see 
Chapter 10, “Creating Workflow Expressions.” 

Delete an element or 
attribute

In the left panel, select the element or attribute you want to 
delete, and click Delete.

Save the XML message Click the Export button to open the XML Finder dialog box. 
Use the XML Finder to save the XML message. For details 
about the XML Finder, see Chapter 12, “Using the XML 
Finder to Access XML Entities.”

To . . . Perform This Action . . .
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4. Complete the fields as described in the following table. Then click OK to set the 
workflow comment or Cancel to cancel the operation.

Defining Integration Actions

This section describes how to use the following integration actions:

n Post XML Event

n XSL Transform

n Send XML to Client

n Call Program

n Perform Business Operation

Post XML Event

Use this action to send an XML message to a specified destination to trigger an event. 
This action can trigger two kinds of events:

In this field . . . Do this . . .

Comment Enter a valid workflow expression to be evaluated at run time. 
The text is typically informative, or it requests the user to 
perform manual actions for which the workflow does not 
provide further automated support.

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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n An internal event in BEA WebLogic Process Integrator. As an internal event, the 
Post XML Event action can: 

l Trigger an Event node in the current workflow or another one. For details 
about defining event nodes, see “Defining Event Node Properties” on page 
8-13.

l Start another workflow for which the Start node is triggered by an event. For 
details about using event triggers in Start nodes, see “Defining an 
Event-Triggered Start Node” on page 8-4.

n An external event in a JMS topic or JMS queue. As an external event, the Post 
XML Event can communicate with an external application that subscribes to the 
JMS topic you specify, or with a specific application that is the JMS queue 
receiver.

To define a Post XML Event action:

1. Access the Add Action dialog box. This dialog box can be accessed from the 
various Properties dialog boxes in BEA WebLogic Process Integrator. For 
example, in the workflow drawing area, right-click a task and choose Properties. 
The Task Properties dialog box is displayed.

2. In the Task Properties dialog box, click Add to display the Add Action dialog 
box.

Note: If a plug-in is defined for actions, this dialog box contains the new action. 
For more information about plug-ins, see Chapter 2, “Configuring 
Plug-Ins.” 

3. Under Integration Actions, select Post XML Event and click OK to display the 
Post XML Event dialog box.

4. Select the XML Message tab to define the XML message you want this action to 
send. The XML message you define is stored in the workflow template 
definition.

If the XML document is stored in an XML type variable, select the From XML 
Variable option and select the variable from the drop-down list. For details about 
XML type variables, see “Defining Workflow Variables” on page 7-8.

If you want to compose the XML message, select the By Composing option and 
compose the message. For details about composing the XML document, see 
“Composing XML Documents” on page 9-22.
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5. (Optional) Select the Message Header tab to specify any JMS message properties 
you want to add to the message, and to set values for standard JMS headers.

JMS messages contain a standard set of header fields that are always transmitted 
with the message. JMS messages also include property fields in which you can 
specify application-specific information. 

JMS message properties are name-value pairs. The name can be almost any 
string that is a valid identifier in the Java language. The value can be any one of 
the following types: Boolean, byte, short, int, long, float, double, or string.

To specify JMS message properties and header fields, complete the fields in the 
dialog box as described in the following table.

In this field . . . Do this . . .

Property/Value Click Add to display the Set JMS Properties dialog box. In the 
dialog box, specify the following:

1. In the JMS Property field, specify the property name.

2. In the JMS Property Value field, enter the property value. 
Enter the value directly or enter an expression that is 
evaluated at run time to produce the value.

3. Click OK.

JMS Headers:

Delivery Mode Select one of the following options:

n Persistent—Persistent messages are not lost even if the JMS 
server fails. The message is delivered again after the server 
recovers.

n Nonpersistent—Nonpersistent messages can be lost if the 
JMS server fails. The message is not delivered again after 
the server recovers.

Priority Assign a priority level to the message using the Priority 
drop-down list. Levels 0-4 are normal priority. Levels 5-9 are 
expedited priority. Messages with an expedited priority are 
delivered ahead of messages with a normal priority. 

Alternatively, you can define an expression that is evaluated at 
run time to produce the value. To use the Expression Builder to 
define an expression, select the Use expression check box.
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6. Select the Destination tab to specify where you want to post the XML message. 
To specify the destination and the transaction mode, complete the fields in the 
dialog box as described in the following table.

Time to live 
(milliseconds)

Specify the length of time the message is to be available before 
it expires. For example, if you want the message to be available 
for 1 hour, you specify a value of 3600000 (1000 milliseconds x 
60 seconds x 60 minutes). The default value of 0 (zero) indicates 
that the message will not expire.

You can enter the value directly, or you can define an expression 
that is evaluated at run time to produce the value. To use the 
Expression Builder to define an expression, select the Use 
expression check box.

In this field . . . Do this . . .

Destination Select the destination for the XML message as follows:

n Select the Internal option if the destination of the message is 
internal to the workflow.

n Select the JMS topic or JMS queue option if the destination 
of the message is external. When either of these options is 
selected, the A+B button becomes active. Enter the JNDI 
name of the JMS topic or queue directly into the expression 
field, or define an expression that is evaluated at run time to 
produce the JNDI name.

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”

In this field . . . Do this . . .
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7. (Optional) Click the Addressing tab to indicate that you want to persist an XML 
message for one or more workflow instances, and to specify an order key. 
Complete the fields in the dialog box as described in the following table.

Transaction Mode If the XML message is part of a transaction, specify how the 
message is to be sent by selecting one of the following options:

n When transaction commits—Select this option to ensure 
that the message is sent only if the transaction completes 
successfully and a commit is issued. If the transaction is 
unsuccessful and is rolled back, the message is not sent.

n Immediately—Select this option to send the message 
immediately without waiting for the transaction to 
complete. 

In this field . . . Do this . . .

Addressed Message Select this check box to indicate that you want to persist a 
message for one or more workflow instances. If a workflow 
instance with the ID you specify is not activated when you send 
the message, BEA WebLogic Process Integrator persists the 
message until a workflow that matches the ID is activated. 

Note: If you specify a Time to live in the Message Header 
area, the message persists only for the time you 
specified. 

Instance ID Enter the ID of the workflow for which you want to persist the 
message, or enter an expression that is evaluated at run time to 
produce the ID.

If you want to persist the message for more than one workflow 
instance, separate the IDs with commas.

In this field . . . Do this . . .
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8. (Optional) Select the Notes tab to enter any notes about this action.

9. Click OK to complete the operation, or Cancel, to cancel the operation.

XSL Transform

Use this action to specify three items: an input XML document that is to be 
transformed, the XSL template document that specifies the details of the 
transformation, and an output variable that will contain the transformed document.

For additional details about this action, see “XSL Transform” in Chapter 7, “Defining 
Actions,” in Using the BEA WebLogic Process Integrator Studio.

To define the XSL Transform action:

1. Access the Add Action dialog box. This dialog box can be accessed from the 
various Properties dialog boxes in BEA WebLogic Process Integrator. For 
example, in the workflow drawing area, you can right-click a task and choose 
Properties; the Task Properties dialog box is displayed.

2. In the Task Properties dialog box, click Add to display the Add Action dialog 
box.

3. Under Integration Actions, select XSL Transform, and click OK to display the 
XSL Transform dialog box.

Order Key Enter a value that specifies the order in which events are 
processed. The order key guarantees that if more than one event 
is posted at the same time, the events are processed by the same 
event listener in the order in which they are received. 

An order key must be an integer value, and the value must be the 
same for each event that you want processed in the order in 
which it is received. For example, if two events are posted at the 
same time, and you want them processed in the order in which 
they are received, enter the same order key value, such as the 
integer value of 8, for each event.

In this field . . . Do this . . .
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4. Complete the fields as described in the following table. Then click OK, to define 
the action, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Input Document Enter a valid workflow expression that represents the XML 
document you want to transform. The expression is evaluated at 
run time to obtain the XML document.

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Transform Document 
Expression

Specify the XSL template document that is used to transform the 
input document. Select from the following options:

n Select the Expression option to specify a workflow 
expression that represents the XSL template document. The 
expression is evaluated at run time to obtain the XML 
document.

If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, 
click the A+B button to display the Expression Builder 
dialog box. For more information about constructing 
expressions, see Chapter 10, “Creating Workflow 
Expressions.”

n Select the Repository option to specify the name of an  XSL 
template document stored in the XML repository. Enter the 
name of the document directly, or click the XML button to 
display the XML Finder dialog box. The XML Finder helps 
you find XML objects stored in the XML repository, in the 
local file system, or at a URL. For more information about 
the XML Finder, see Chapter 12, “Using the XML Finder to 
Access XML Entities.”

Output Variable From the drop-down list, select the variable that will contain the 
transformed XML document. The variable must be an XML 
type variable. You can also type the name of the variable. If it 
does not exist, you will be prompted to create it. For details 
about defining variables, see “Defining Workflow Variables” on 
page 7-8.
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Send XML to Client

Use this action to communicate between a workflow and a client application by 
sending an XML document to the client. The client application must be programmed 
to identify the XML document, perform the appropriate action, and return an XML 
document in response to the workflow.

For examples of using this action with the Worklist application, see “Using the Send 
XML to Client Action with the Worklist Application” in Chapter 7,  “Defining 
Actions,” in Using the BEA WebLogic Process Integrator Studio.

To send an XML message to a client:

1. Access the Add Action dialog box. This dialog box can be accessed from the 
various Properties dialog boxes in BEA WebLogic Process Integrator. For 
example, in the workflow drawing area, right-click a task node and choose 
Properties. The Task Properties dialog box is displayed.

2. In the node Properties dialog box, click Add to display the Add Action dialog 
box.

Note: If a plug-in is defined for actions, this dialog box contains the new action. 
For more information about plug-ins, see Chapter 2, “Configuring 
Plug-Ins.” 

3. Expand the Integration Actions list, select Send XML to Client, and click OK. 
The Send XML to Client dialog box is displayed.

4. Define the XML document you want to send as described in “Composing XML 
Documents” on page 9-22. The XML document you define is stored in the 
workflow template definition.

5. Select the Callback Variables tab to specify the variables that will receive the 
response from the client. Specify a variable for each anticipated response from 
the client.

Notes (Optional) Enter any notes about the action in the free-form text 
field.

In this field . . . Do this . . .
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Click Add to display the Workflow Variable Assignment dialog box. The 
variables in the pull-down list are those defined in the Variables Properties 
dialog box. (For details about defining variables, see “Defining Workflow 
Variables” on page 7-8.) The XML expression can be one of the following:

l The name of an element in the XML message returned by the client, the 
value of which you want to assign to the selected variable 

l An XPath function that extracts a value from the XML message from the 
client, and then assigns that value to the selected variable

6. Select the Callback Actions tab to specify any actions that should be performed 
when the reply is received from the client. 

Click Add to open the Add Action dialog box where you can select the actions 
you want to specify. Typically, you specify the Mark Task as Done action. The 
Mark Task as Done action indicates that the client has returned a response, and 
control can return to the Send XML to Client action.

7. (Optional) Select the Notes tab to add free-form text notes about this action.

8. Click OK, to complete the operation, or Cancel, to cancel the operation.

Call Program

Use this action to call an executable program on the workflow server. This action is 
executed asynchronously, meaning that any actions following this action in the list are 
executed immediately, without waiting for the called program to complete.

To define a call program action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Integration Actions list and select the Call Program action.

3. Click OK to display the Call Program dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.
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Perform Business Operation

Use the Perform Business Operation action to invoke a predefined business operation 
on an Enterprise JavaBean (EJB) or Java class. The results of such an invocation can 
be assigned to workflow variables. The Perform Business Operation action is linked to 
a BEA WebLogic Process Integrator function called Business Operations (accessed 
through the Configuration menu). For instructions on creating business operations, see 
Chapter 6, “Defining Business Operations.”

To define a Perform Business Operation action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Integration Actions list and select the Perform Business Operation 
action.

3. Click OK to display the Perform Business Operation dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Program Enter a fully qualified path to an executable program to execute 
at run time.

Arguments Enter a valid workflow expression to be evaluated at run time 
and passed to the called program.

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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In this field . . . Do this . . .

Operation Select the predefined business operation to be invoked. Business 
operations in BEA WebLogic Process Integrator are Enterprise 
JavaBean (EJB) or Java based. These operations are defined 
using the Define Business Operation dialog box, as discussed in 
the section entitled “Defining a Business Operation” on page 
6-2.

Instance Variable Select the instance variable, that is, the variable containing the 
Java object or EJB on which WebLogic Process Integrator 
should invoke the business operation. 

The Instance Variable option is activated if the business 
operation represents one of the following:

n EJB remote method

n Java class non-static, non-constructor method

In such cases, the instance variable drop-down list displays 
defined Java object, Session EJB, and Entity EJB type variables.

To create a new instance variable, click Add to display the 
Variable Properties dialog box. For instructions on defining a 
variable, see “Defining Workflow Variables” on page 7-8.

Parameters If the business operations requires parameter input, you must 
enter values for the parameters. The business operation is called 
based on these actual values. 

To add a parameter value to a listed parameter:

1. Highlight the parameter in the list.

2. Click Update to display the Expression Builder dialog box.

3. Define the expression and click OK to accept the value 
entered or Cancel to cancel the operation.

For details about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Assign result to From the drop-down list, select a workflow variable to which to 
assign the result of the business operation. 

To create a new variable to which you can assign the result, click 
Add; the Variable Properties dialog box is displayed. For 
instructions on how to define a variable, see “Defining 
Workflow Variables” on page 7-8.
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Defining Exception-Handling Actions

This section describes how to define the following exception-handling actions:

n Invoke Exception Handler

n Set Workflow Exception Handler

n Exit Exception Handler

Invoke Exception Handler

Use this action to allow the invocation of a specific exception handler within a 
workflow. When the Invoke Exception Handler action is executed, WebLogic Process 
Integrator sends the user-defined XML document to the exception processor and 
invokes the specified exception handler.

To invoke an exception handler:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Exception Handling Actions list and select the Invoke Exception 
Handler action.

3. Click OK to display the Invoke Exception Handler dialog box.

Note: You cannot invoke one exception handler from within another. Therefore, 
if you access the Add Action dialog box from within an exception handler, 
the Invoke Exception Handler action is not available.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Notes (Optional) Enter any notes about the action in the free-form text 
field.

In this field . . . Do this . . .
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In this field . . . Do this . . .

Exception Handler 1. Click the arrow to display a drop-down list of exception 
handlers.

2. Select the exception handler to invoke. 

If no custom-defined exception handlers exist, the system 
exception handler is used by default; it is invoked whenever an 
exception occurs. The system exception handler is available for 
use at all times, even if custom handlers are defined.

XML Document 
Structure

(Optional) Create an XML document structure containing 
elements, subelements, and attributes, as described in the 
following procedure:

1. Select either the Element or Attribute option button, 
depending on what you are adding to the XML document 
structure.

2. In the Name field, enter the name of the element or attribute, 
and click Add to add it to the XML document.

3. Use the directional arrows to the right to move the element 
or attribute forward or backward, up or down, depending on 
where you need to position it in the structure. Moving an 
element or attribute forward makes it a subelement of the 
previous main node.

To define the value for an element or an attribute: 

1. Select the element or attribute from the XML structure. 

2. Enter a value in the Value Expression field. The value can 
be either a string, typed in quotes, or an expression 
containing workflow variables and functions. For details 
about creating a workflow expression, see Chapter 10, 
“Creating Workflow Expressions.”

Note: Creating an XML document within this action is 
optional. This action can be used just to invoke an 
exception handler and not necessarily to send 
information through XML.

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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Set Workflow Exception Handler

Use this action to make a specified exception handler the active exception handler for 
a workflow template definition. If this action is not used in the workflow template 
definition and no other exception handler is defined and marked as the initial exception 
handler, the system exception handler, by default, is used and invoked whenever an 
exception occurs. 

To use the set workflow exception handler action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Exception Handling Actions list and select the Set Workflow 
Exception Handler action.

3. Click OK to display the Set Workflow Exception Handler dialog box.

4. Complete the fields as described in the following table. Then click OK, to set the 
exception handler, or Cancel, to cancel the operation.

Exit Exception Handler

Use this action to exit an exception handler using one of four methods: rollback, stop, 
retry, or continue. 

In this field . . . Do this . . .

Exception Handler 1. Click the arrow to display a drop-down list of exception 
handlers.

2. Select one exception handler as the active exception 
handler. 

If no custom-defined exception handlers exist, the system 
exception handler is used by default, as the active exception 
handler. The system exception handler is available for use at all 
times, even if custom handlers are defined.

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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Note: This action is displayed in the Add Actions dialog box only when this dialog 
box is accessed from one of two tabs—the Actions on Commit tab or the 
Actions on Rollback tab—of the Exception Handler Properties dialog box. See 
“Defining Exception Handlers” on page 7-10.

1. From the Exception Handler Properties dialog box, select either the Actions on 
Commit or Actions on Rollback tab. 

2. Click Add to display the Add Action dialog box.

3. Expand the Exception Handling Actions list and select the Exit Exception 
Handler action.

4. Click OK to display the Exit Exception Handler dialog box.

5. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.
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Defining Miscellaneous Actions

This section explains how to define the following miscellaneous actions:

n No Operation

In this field . . . Do this . . .

Exit Method Select one of the following methods for exiting the exception 
handler:

n Rollback—Marks the user transaction for rollback only, 
returning the workflow to the state in which it existed before 
the start of the transaction. The exception is propagated to 
the client (if any) as a Workflow Exception.

Note: In the Rollback path, the only exit option available in 
the Exit Exception Handler action is Rollback. When a 
transaction is rolled back, there are no options other 
than rollback.

Certain Enterprise Java Beans (EJBs) can mark a 
transaction for rollback through only one of two 
methods: by calling a UserTransaction method; or by 
throwing an unchecked exception across a container 
boundary. In either case, WebLogic Server rolls back 
the transaction.

n Stop—Exits the error handler and does not execute any 
subsequent actions.

n Retry—Exits the error handler and attempts to retry the 
failed operation. (The failed operation is an action or the 
setting of a variable.)

n Continue—Stops the execution of the exception handler and 
attempts to continue the execution of the workflow at the 
next operation. (The next operation is the next action or the 
next variable to be set.)

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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n Send E-Mail Message

n Evaluate Condition

n Timed Event

n Cancel Workflow Event

n Make Audit Entry

No Operation

The No Operation action has no function; it simply acts as a placeholder to remind an 
analyst to add an action at a later time.

To define a No Operation action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the No Operation action.

3. Click OK to display the No Operation dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Send E-Mail Message

Use this action to send an e-mail message to a user of the BEA WebLogic Process 
Integrator system or even to an outside party. The SMTP protocol (an Internet 
standard) is used to transmit the message.

In this field . . . Do this . . .

Description Enter a descriptive name for the No Operation action (preferably 
a name that will remind you to add an action at a later time.)

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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Note: This action requires configuration in the config.xml file and EJB 
deployment. For configuration information, see Installing and Configuring 
BEA WebLogic Process Integrator.

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the Send E-Mail Message 
action.

3. Click OK to display the Send E-Mail Message dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Subject Enter a valid workflow expression or a literal value, between 
double quotes, that will be evaluated at run time for the text of 
the subject line of the e-mail.

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Message tab Enter a valid workflow expression or a literal value, between 
double quotes, that will be evaluated at run time for the message 
text of the e-mail.
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To, CC, and BCC tabs Use these tabs to specify how the e-mail should be addressed. To 
specify an e-mail recipient:

1. Select the appropriate To, CC, or BCC tab.

2. Click the Add or Update button to display the Mail 
Recipient dialog box.

3. Select the recipient using one of the following options:

l Address—Select this option to enter an e-mail address. 
Enter the address in the blank field at the bottom of 
the dialog box.

l User—Select this option to send the e-mail to a user in 
the organization. Select the recipient from the 
drop-down list of available users. The e-mail address 
is obtained from the user’s profile.

l Role—Select this option to send the e-mail to a role in 
the organization. Select the role from the drop-down 
list of available roles. The e-mail message will be sent 
to all users assigned to that role.

You can also specify an e-mail address using a valid 
workflow expression. To do so, select the Expression 
check box and enter a workflow expression. 

4. Click OK to complete the operation or  Cancel to cancel the 
operation. 

Notes tab (Optional) Click this tab and enter any notes about the action in 
the free-form text field.

In this field . . . Do this . . .



Defining Miscellaneous Actions

BEA WebLogic Process Integrator Studio Online Help 9-43

Evaluate Condition

Use this action to evaluate a conditional expression at run time and to perform 
alternative sequences of subactions, depending on the result. If the condition evaluates 
to True, one sequence of actions is performed; if to False, a different sequence of 
actions is performed, instead.

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the Evaluate Condition action.

3. Click OK to display the Evaluate Condition dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Condition Enter a valid workflow condition that will be evaluated at run 
time to determine which set of subactions to perform.

 If you know the syntax of the condition you want to use, you can 
enter it directly in the field. Alternatively, click the A+B button 
to display the Expression Builder dialog box. For more 
information about constructing expressions and conditions, see 
Chapter 10, “Creating Workflow Expressions.”

Actions to execute by 
condition result

Use this field to specify subactions to be executed, based on the 
result of the condition evaluation.

Select the True tab and click Add to specify subactions to be 
executed if the condition evaluates to true.

Select the False tab and click Add to specify subactions to be 
executed if the condition evaluates to false.

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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Timed Event

Use this action to create a timed event that will be triggered at an exact time and date, 
as specified by an execution schedule.

To specify a timed event:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the Specify Timed Event action.

3. Click OK to display the Specify Timed Event dialog box.

The dialog box consists of four tabs: Trigger Event, Execution Schedule, Actions 
when triggered, and Notes. The following steps describe how to complete the 
fields displayed on each tab.

4. Select the Trigger Event tab (if not already selected).  Complete the fields as 
described in the following table.

In this field . . . Do this . . .

From action execution 1. Select this option to trigger the timed event, using a 
specified unit of time. 

2. Select the unit of time from the drop-down list. 

3. Enter a number to be associated with the unit of time in the 
field to the left of the drop-down list. For example, if you 
enter the number 4 and select Minutes from the drop-down 
list, the event will be triggered four minutes after the 
preceding event is executed.

To Expression 1. Select this option to trigger the timed event, using a date 
expression.

2. If you know the syntax of the expression you want to use, 
enter the expression directly in the field. Alternatively, click 
the A+B button to display the Expression Builder dialog 
box. The Expression Builder helps you construct an 
expression, which is made up of functions, operators, 
literals, and variables. For more information about 
constructing expressions, see Chapter 10, “Creating 
Workflow Expressions.”
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5. Select the Execution Schedule tab. This tab allows you to specify that the event 
will be repeated, at specified intervals, until the task is marked done or the 
workflow template definition is done. Complete the fields as described in the 
following table.

6. Select the Actions when triggered tab and add, update, or delete actions to be 
triggered by the timed event.

7. Select the Notes tab to enter notes about the action in the free-form text field.

8. Click OK to complete the operation, or Cancel, to cancel the operation.

Business Calendar If you selected the interval Business Hours or Business Days in 
the From action execution field, the business calendar is used. 

Select one of the following business calendars from the 
drop-down list:

n For Organization—This option uses the business calendar 
assigned to the organization for which the workflow 
template definition instance will be executed.

n For Assignee—This option uses the calendar that belongs to 
the user or role that owns the task that precedes the event to 
be triggered.

In this field . . . Do this . . .

Reschedule every 1. Select the unit of time from the drop-down list. 

2. Enter a number to be associated with the unit of time in the 
field to the left of the drop-down list. For example, if you 
enter the number 4 and select Minutes from the drop-down 
list, the event will be rescheduled every four minutes.

Stop execution when Select one of the following options:

n Workflow is done. The trigger will stop when the entire 
workflow is completed.

n Task is done. The trigger will stop when the preceding task 
in which this action is specified is marked as done.

In this field . . . Do this . . .
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Cancel Workflow Event

Use this action to cancel an event that is defined within a workflow.

To cancel a workflow event:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the Cancel Workflow Event 
action.

3. Click OK to display the Cancel Workflow Event dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

Make Audit Entry

This action allows you to specify an additional audit entry expression. This audit entry 
will be published to a Java Message Service (JMS) topic for further retrieval.

Note: The JMS topic is specified in the Template Definition Properties dialog box. 
For further information, see “Creating a New Template Definition” on page 
7-3.

To use the Make Audit Entry action:

1. In the node Properties dialog box, click Add to display the Add Action dialog box.

2. Expand the Miscellaneous Actions list and select the Make Audit Entry action.

In this field . . . Do this . . .

Event to cancel This field displays all events defined in the workflow. 

Select the workflow event to be canceled. (Hold down the Ctrl 
key to select more than one event.)

Notes (Optional) Enter any notes about the action in the free-form text 
field.
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3. Click OK to display the Make Audit Entry dialog box.

4. Complete the fields as described in the following table. Then click OK, to 
complete the operation, or Cancel, to cancel the operation.

In this field . . . Do this . . .

Audit entry expression Enter an audit entry expression to be sent to the audit listener for 
further retrieval at run time.

If you know the syntax of the expression you want to use, enter 
the expression directly in the field. Alternatively, click the A+B 
button to display the Expression Builder dialog box. For more 
information about constructing expressions, see Chapter 10, 
“Creating Workflow Expressions.”

Notes (Optional) Enter any  notes about the action in the free-form text 
field.
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CHAPTER

10 Creating Workflow 
Expressions

The following sections help you build workflow expressions in the Studio:

n What Is a Workflow Expression?

n Using the Expression Builder

n Defining the Components of an Expression

n Interpreting Invalid Expression Messages

See Also

Creating XPath Expressions Using the XPath Wizard

What Is a Workflow Expression?

A workflow expression is an algebraic expression that defines a calculation performed 
by the BEA WebLogic Process Integrator system at run time. You build workflow 
expressions using the BEA WebLogic Process Integrator expression syntax, which is 
comparable to that of Structured Query Language (SQL). You can also use XPath 
function syntax to extract values from XML documents. The WebLogic Process 



10 Creating Workflow Expressions

10-2 BEA WebLogic Process Integrator Studio Online Help

Integrator expression syntax makes it easy to manipulate strings, test for relationships 
and conditions, and perform arithmetic calculations involving workflow variables, 
database fields, and literal values (constants).

The result of an expression may be a string, a string representation of an integer, a 
double, a date/time value, or either of the Boolean (logical) values True and False. 
Expressions that yield a Boolean result are referred to as conditional expressions or 
conditions.

Using the Expression Builder

The Expression Builder enables you to build expressions to be executed in BEA 
WebLogic Process Integrator at run time. Expressions are made up of functions, 
operators, literals, and variables. For additional information about expression 
components, see “Defining the Components of an Expression” on page 10-3.

To use the expression builder:

1. Click the A+B Expression Builder button in one of the dialog boxes for a workflow 
component. The Expression Builder dialog box is displayed.

2. To create an expression, either type it directly in the Expression field or insert 
components from one of the following categories:

l Functions

l Operators

l Literals

l Variables

3. To insert components from one of the four categories, select the option for the 
category of your choice and double-click a component from the scrollable 
list-box. The selected component is inserted into the Expression field using the 
correct syntax. 

In some cases, the inserted item contains placeholders. You can either replace 
the placeholders by typing the correct information or by inserting additional 
components from the component lists.
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4. To create XPath expressions, you can either type them yourself, or you can use 
the XPath wizard. To open the XPath wizard, click the XPath Wizard button. For 
details about using the wizard, see Chapter 11, “Creating XPath Expressions 
Using the XPath Wizard”

5. Click OK to complete the operation or Cancel to cancel the operation.

If the expression is valid, the message Expression is valid is displayed in 
the Expression Builder dialog box; otherwise, an error message is presented in a 
dialog box. Validation does not perform the following tasks:

l Check the validity of a workflow variable referenced by the expression

l Check for the correct number of parameters being passed to a function

l Attempt to do type checking

If there is a type mismatch in the expression (for example, if an attempt is made 
to perform an arithmetic operation on a non-numeric string), a run-time error 
results when the expression is evaluated. 

If you enter an invalid expression, the system displays a message that attempts to 
explain why the expression is invalid. For assistance in interpreting these error 
messages, see “Interpreting Invalid Expression Messages” on page 10-8.

Defining the Components of an Expression

The following sections describe the components provided by BEA WebLogic Process 
Integrator to construct workflow expressions. For additional information, see Chapter 
8, “Using Expressions and Conditions,” in Using the BEA WebLogic Process 
Integrator Studio.

Defining Functions

BEA WebLogic Process Integrator provides the following functions that you can use 
to construct conditions.
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Function Description

Abs(number) Returns the absolute value of the expression.

CurrentUser Returns the ID of the user currently executing a 
task.

Date() Returns the current system date.

DateAdd(date, interval, 
number [,buscal])

Performs date arithmetic.

DateToString(date, format) Converts a date to a string.

EventAttribute(attribute) Obtain event properties from an incoming 
EventData object, such as a JMS message 
property.

EventData() Retrieve the content of the incoming JMS 
message. The content could be an XML 
document. 

StringLen(string) Provides the string length.

StringToDate(string, format) Converts a string to a date.

SubString(string, start 
[,length])

Extracts a substring from a string.

TaskAttribute(attribute 
[,taskname])

Provides the task attribute.

ToInteger(expression) Converts a string value to an integer.

ToString(expression) Converts any data type value to a string.

WorkflowAttribute(attribute) Provides a workflow attribute.

WorkflowVariable(instanceid, 
variable)

Returns the value of a workflow variable for a 
particular workflow instance.

XPath(xpathstring, 
xmldocument)

Provides the XPath expression. For additional 
information about defining XPath expressions, 
see Chapter 11, “Creating XPath Expressions 
Using the XPath Wizard”
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Using Operators

BEA WebLogic Process Integrator provides the following operators that you can use 
to construct expressions and conditions.

Table 10-1  Operator Values

Operator Symbol Syntax Operands Result

AND AND expr1 AND 
expr2

Logical True if expr1 and expr2 are 
both True; otherwise False

OR OR expr1 OR expr2 Logical True if either expr1 or both 
expr1 and expr2 are True; 
otherwise False

XOR XOR expr1 XOR 
expr2

Logical True if either expr1 or expr2 
is True (but not both); otherwise 
False

NOT NOT NOT expr Logical True if expr is False; otherwise 
False

(parentheses) () (expr) Any expression Evaluates expr first

Multiply * expr1 * expr2 Numeric Numeric product

Divide / expr1 / expr2 Numeric Numeric quotient

Modulo % expr1 % expr2 Numeric Numeric modulus (remainder 
when expr1 is divided by 
expr2)

Plus + + expr

expr1 + expr2

Numeric

String or numeric

Unary plus

String concatenation or numeric 
addition

Minus - - expr

expr1 – expr2

Numeric

Numeric

Unary minus (negates expr)

Subtraction

Less than < expr1 < expr2 String or numeric Logical True if expr1 is less 
than expr2; otherwise False
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Using Literals

Expressions can contain literal values, or constants. The following table describes the 
available literals.

Less than or 
equal to

<= expr1 <= expr2 String or numeric Logical True if expr1 is less 
than or equal to expr2; 
otherwise False

Equal to = expr1 = expr2 String or numeric Logical True if expr1 is equal 
to expr2; otherwise False

Not equal to <> expr1 <> expr2 String or numeric Logical True if expr1 is not 
equal to expr2; otherwise False

Greater than > expr1 > expr2 String or numeric Logical True if expr1 is greater 
than expr2; otherwise False

Greater than or 
equal to

>= expr1 >= expr2 String or numeric Logical True if expr1 is greater 
than or equal to expr2; 
otherwise False

Table 10-1  Operator Values

Operator Symbol Syntax Operands Result
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Using Variables

An expression can contain references to any workflow variable defined in the 
associated workflow and to any system-defined variable.

Any of the following syntaxes can be used in a workflow variable reference:

n :variable

Table 10-2  Literal Values

Literal Type Syntax Description

String “string” or ‘string’ A character string enclosed in 
single or double quotes. Use the 
following escape sequences to 
embed special characters in the 
string:

\r  carriage return character

\n  line feed character

\’  single quote character

\”  double quote character

\f  form-feed character

\t  tab character

\\  backslash character

\0  ASCII null character

Integer [+|-] digits A 32-bit signed integer in the range
-2,147,483,647 to +2,147,483,648 
(approximately 9 digits of 
precision)

Double [+|-]digits[.[digits]] A 64-bit IEEE double in the range 

–253 x 10104 to + 253 x 10104 
(approximately 15 digits of 
precision)

Date/Time {yyyy/mm/dd hh:nn:ss} A date and time 
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n :’variable’

n :"variable"

n $variable

n $'variable'

n $"variable"

For consistency with XPath functions, use of the $ notation is recommended.

Interpreting Invalid Expression Messages

The following table lists the messages that may be encountered, together with possible 
causes.

Table 10-3  Invalid Expression Messages

Message Possible Causes

Invalid <operator> operand One or both of the operands is not valid for one of the following 
operators: AND, OR, XOR, NOT,*,/,%,+,-,<,<=,=,<>,>=,>. 
For example, if you attempt to perform arithmetic on a 
non-numeric string, such as: "Name: " * 25.4. 

Mismatched operand types 
in <operator> comparison 

An attempt is being made to compare values of different types. 
For example, comparing a date to a number: {97/09/30} <= 
56.9. 

NumberFormatException A string representation of a number is not formatted using the 
required format for the type of number. For example: 1.23ZX.

Invalid function name The expression is calling an undefined function. For example: 
"Name: " + somefunc(:var). somefunc is not a valid 
function name. 

Incomplete escape 
sequence 

The last character in a quoted string is a backslash character 
that is not followed with one of the following characters: r, n, 
f, t, \, ’, ",0.
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Invalid escape sequence A quoted string contains a backslash character that is not 
followed with one of the following characters: r, n, f, t, \, ’, ",0.

Fatal error An internal error has occurred in the expression evaluator. The 
expression probably contains a syntax error.

Unclosed string A closing quote is missing from the end of a literal string. In the 
following example, a literal string is enclosed in quotes but the 
opening and closing quotes (double quotes and a single quote, 
respectively) do not match so the quote syntax is not valid: 
“This is an unclosed string.’

Illegal character The expression contains a character that violates the syntax of 
the expression language. In the following example, ! is the 
invalid character: 7 * :wks + " days" !.

Error: unmatched input The evaluator cannot interpret the expression. The expression 
probably contains a syntax error. 

Unrecoverable syntax error The expression contains an invalid token. In this example, the 
name is invalid because the + operator is missing: "Name: " 
name.

The following expression should be used: "Name: " + name.

Table 10-3  Invalid Expression Messages

Message Possible Causes
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CHAPTER

11 Creating XPath 
Expressions Using the 
XPath Wizard

The following sections describe how to create XPath expressions in the Studio with the 
XPath wizard:

n Using the XPath Wizard

n Using XPath Expressions and Functions From the Expression Builder

Using the XPath Wizard

The XPath Wizard is accessible through the Expression Builder dialog box. For details 
on the Expression Builder, see Chapter 10, “Creating Workflow Expressions.”

To access the XPath Wizard:

1. Click the A+B Expression Builder button in one of the dialog boxes for a workflow 
component. The Expression Builder dialog box is displayed.

2. Click the XPath Wizard button. The XPath Wizard dialog box is displayed.

The XPath wizard provides a graphical interface that you can use to define, edit, and 
test XPath location expressions and XPath functions. Specifically, you can:
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n Create XPath location expressions and functions for sample XML, DTD, and 
schema documents

n Test the XPath location expressions and functions you create by applying them 
to XML documents

n View all the XPath location expressions and functions you create during a 
Studio session

The following sections provide details about these tasks. You can also view 
information about using the XPath wizard by clicking the Show Information button in 
the wizard menu bar.

Creating XPath Location Expressions

Using the XPath wizard, you can create XPath location expressions that target:

n Element content

n Attribute content

n Nodes

To create an XPath location expression:

1. Select the Sample tab to open the Sample area where you can create XPath 
expressions.

2. Click the Open button to open the XML Finder dialog box. Use the XML Finder 
dialog box to retrieve an XML, DTD, or schema (XSD) document that you can 
use the create the XPath expression. For details about the XML Finder, see 
Chapter 12, “Using the XML Finder to Access XML Entities.”

If you open a DTD or XSD document, the wizard generates a sample XML 
document from the DTD or schema you selected. You use the generated XML 
document to create the XPath expression.

After you retrieve the document using the XML Finder, the content of the 
document appears in the XPath wizard.

The Document Type field shows you the type of the currently open document, 
and the Document Location field shows you the path of the document.
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3. Select the markup or content for an element, attribute, or node that you want to 
be the target of the XPath expression. 

The wizard generates an XPath expression based on your selection, and displays 
it in the XPath Expression field.

4. Click the Pin button to put the XPath expression you created in the Workspace.

The Workspace provides a convenient area where you can hold all the XPath 
expressions you create during a session of the Studio. 

Every time you create an XPath expression, you can pin it to the Workspace. 
This way, you can create multiple expressions for a single XML document, and 
then test them later to ensure they return the correct result.

5. Select the Workspace tab to view the expressions you create. For details, see 
“Viewing XPath Location Expressions” on page 11-3.

6. Select the Test tab to test the expressions you create. For details, see “Testing 
XPath Location Expressions” on page 11-4.

7. Click OK to return the expression to the Expression Builder.

Viewing XPath Location Expressions

After you create your XPath location expressions and pin them to the Workspace, you 
can view them in the Workspace.

To view the XPath expressions you created, select the Workspace tab.

The Workspace shows you the following information:

n XPath Expression—lists the expressions you create during a session of the 
Studio.

n Target—lists the element or attribute in the XML document that is the target of 
the XPath expression

n Document—lists the source document from which the XPath expression was 
created

In the Workspace, you can select an expression to test. For details, see “Testing XPath 
Location Expressions” on page 11-4. 
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Testing XPath Location Expressions

After you create your XPath location expressions, you can test them against a target 
XML document.

To test an XPath expression:

1. In the Workspace, select the expression you want to test.

2. Select the Test tab. 

The Test area shows you the XML document with the target of the XPath 
expression highlighted.

3. If necessary, you can modify the XPath expression by editing it in the XPath 
Expression field. 

4. To test the expression again, click the Checkmark icon. The new result of the 
expression is highlighted in the XML document.

Creating and Testing XPath Functions

The XPath function library provides functions that you can use to perform operations 
on the function arguments. Using the XPath wizard, you can create the following types 
of XPath functions:

n String functions that perform operations on the string contents of nodes and 
attributes, such as accessing, extracting, and combining

n Boolean functions that perform Boolean tests or operations on their arguments, 
and that return a value based on the test or operation

n Number functions that return numeric results, such as a count of nodes in an 
document, or the sum of numeric content

n Node set functions that return information about individual nodes or node sets

To create an XPath function:

1. Select the Sample tab to open the Sample area where you can create XPath 
functions.
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2. Click the Open button to open the XML Finder dialog box. Use the XML Finder 
dialog box to retrieve an XML, DTD, or schema (XSD) document for which you 
want to create the XPath function. For details about the XML Finder, see 
Chapter 12, “Using the XML Finder to Access XML Entities.”

3. Select the markup or content for an element, attribute, or node that you want to 
be part of the XPath function.

4. Select the Test tab.

5. Complete the XPath function in the XPath Expression field.

Alternatively, after you open the document for which you want to create the XPath 
function, you can select the Test tab and enter the entire XPath function in the XPath 
Expression field.

To test the function:

1. Click the Checkmark icon. The return value of the function is displayed as a literal 
in the Test area.

2. If necessary, modify the XPath function by editing it in the XPath Expression 
field. 

3. To test the function again, click the Checkmark icon. The new return value of the 
function is displayed in the Test area.

To view all the functions you create and pin during a Studio session, select the 
Workspace tab.

To return the function to the Expression Builder, click OK.
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Using XPath Expressions and Functions 
From the Expression Builder

If you have an XPath location expression or function in the Expression Builder, you 
can pass it to the XPath wizard, and then use all the functions in the wizard to edit and 
test the expression or function.

To pass an expression or function from the Expression Builder to the XPath wizard:

1. In the Expression Builder, display the XPath expression or function you want to 
pass to the wizard.

2. Click the XPath Wizard button.

The XPath expression or function is passed to the XPath wizard, and appears as 
the first item in the XPath Expression list in the Workspace. 
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CHAPTER

12 Using the XML Finder 
to Access XML Entities

The following sections explain how to use the XML Finder to find XML entities, and 
how to manage XML entities in the XML repository:

n Using the XML Finder

n Managing the XML Repository

Using the XML Finder

The XML Finder dialog box helps you find XML entities stored in the XML 
repository, or the local file system, or at a URL. The dialog box also maintains a list of 
the XML entities you used most recently, so you do not have to search for them if you 
want to use them again. XML entities can be XML documents, DTD files, schema 
files, and XSLT template documents. Once you select an XML entity, the XML Finder 
returns the entity to the Studio.

Retrieving the Most Recently Used XML Entities

1. In the XML Finder dialog box, select the Recent tab.

2. Select the entity you want to use.
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3. To see the contents of the entity, click Preview. Click OK in the Preview 
Document dialog box to return to the XML Finder.

4. To return the entity to the Studio, click OK in the XML Finder dialog box. Click 
Cancel to cancel the operation.

Retrieving XML Entities from the XML Repository

The XML Finder provides a way to obtain XML entities stored in the XML repository 
maintained by BEA WebLogic Process Integrator. The XML Finder also provides a 
way to manage the entities in the repository. For more information, see “Managing the 
XML Repository” on page 12-3. 

To retrieve an entity from the repository:

1. In the XML Finder dialog box, select the Repository tab.

2. Select the folder from which you want to retrieve an XML entity.

The left panel shows you a tree view of the repository with folders and 
subfolders arranged hierarchically. The top-most panel on the right shows you 
the contents of the selected folder. The Description field contains a description 
of the selected folder, and the Notes field contains any notes about the selected 
folder. 

3. In the top-most panel on the right, select the entity you want to retrieve.

4. To see the contents of the entity, click Preview. Click OK in the Preview 
Document dialog box to return to the XML Finder.

5. To return the entity to the Studio, click OK in the XML Finder dialog box. Click 
Cancel to cancel the operation.

Retrieving XML Entities from the Local File System

1. In the XML Finder dialog box, select the File tab.

Note: The File tab is unavailable if you access the XML Finder from a dialog box 
that you are using to specify an action that takes place at run time. For 
example, if you access the XML Finder from the XSL Transform dialog 
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box, the File tab is unavailable because the XSL transformation occurs at 
run time. Specifying an XSL template document located on the local file 
system is not appropriate in this case because BEA WebLogic Process 
Integrator can not access the local file system at run time.

2. In the Look in field, specify the drive and folder from which you want to obtain 
the XML entity. If necessary, use the buttons to the right of the Look in field to 
browse the file system.

3. From the file list, select the entity you want to retrieve.

4. To see the contents of the entity, click Preview. Click OK in the Preview 
Document dialog box to return to the XML Finder.

5. To return the entity to the Studio, click OK in the XML Finder dialog box. Click 
Cancel to cancel the operation.

Retrieving XML Entities from a URL

1. In the XML Finder dialog box, select the URL tab.

2. In the URL field, enter the complete URL, including the filename, of the XML 
entity you want to retrieve.

3. To see the contents of the entity, click Preview. Click OK in the Preview 
Document dialog box to return to the XML Finder.

4. To return the entity to the Studio, click OK in the XML Finder dialog box. Click 
Cancel to cancel the operation.

Managing the XML Repository

The XML repository, maintained by BEA WebLogic Process Integrator, is used to 
store XML entities, such as XML documents, DTD files, and XSL template 
documents. 

You can view the contents of the repository, and perform actions on the repository, on 
folders in the repository, and on XML entities in folders.
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Viewing the Contents of the Repository 

You can view the contents of the entire repository, or the contents of individual folders 
in the repository.

To view the contents of the entire repository, 

1. In the Studio menu bar, choose Tools→Show XML Finder. The XML Finder 
dialog box opens with the Repository tab selected.

2. In the left panel, select XML Repository.

The left panel displays a tree view of the repository with folders and subfolders 
arranged hierarchically. The top-most panel on the right displays a detailed view 
of the repository. The Folders field lists all the folders in the repository. The 
Entities field lists all the XML entities in the repository. 

3. To view the contents of a folder, select the folder you want to view.

The top-most panel on the right displays the contents of the selected folder. The 
Description field contains a description of the selected folder, and the Notes field 
contains any notes about the selected folder. 

The XML repository stores different types of XML entities, each represented by a 
symbol, as shown in the following table.

Symbol XML Entity Type

DTD file

MFL file

Schema file

Text file
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You can also export the contents of the repository to a Java Archive (JAR) file, and 
import the contents of a JAR file into the repository. For details, see “Exporting and 
Importing Workflow Packages” on page 7-20.

Adding Folders to the Repository

1. In the XML Finder dialog box, select the Repository tab.

2. Select XML Repository in the tree-view in the left panel and right-click. 

3. Select Add Folder from the pop-up menu. The Add Folder dialog box is 
displayed.

4. In the Name field, enter the name of the folder.

5. Optionally, enter a description and notes about the folder in the Description and 
Notes fields, respectively.

6. Click OK, to add the folder, or Cancel, to cancel the operation.

Updating Folders in the Repository

1. In the XML Finder dialog box, select the Repository tab.

2. Select the folder to be updated in the tree-view and right-click. 

3. Select Update Folder Info from the pop-up menu. The Update Folder Info dialog 
box is displayed.

4. Change the contents of the Name, Description, and Notes fields as necessary.

XML document

XSLT template document

Symbol XML Entity Type
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5. Click OK, to update the folder information, or Cancel, to cancel the operation.

Deleting Folders from the Repository

1. In the XML Finder dialog box, select the Repository tab.

2. Select the folder to be deleted in the tree-view and right-click. 

3. Select Delete Folder from the pop-up menu. A dialog box is displayed prompting 
you to confirm the deletion.

4. Click Yes, to delete the folder, or No, to cancel the delete operation.

Adding an Entity to a Folder

1. In the XML Finder dialog box, select the Repository tab.

2. Select the folder to which you want to add the entity in the tree-view and 
right-click. 

3. Select Add Entity from the pop-up menu. The Add Entity dialog box is 
displayed. 

4. Complete the fields as described in the following table.

5. (Optional) Click View to display the contents of the entity you are adding.

In this field . . . Do this . . .

Name Enter a unique name for the entity you are adding.

Type Select the type of entity you are adding from the drop-down list.

Description (Optional) Enter a description of the entity.

Notes (Optional) Enter any notes about the entity.

Content URL Enter the URL of the entity you are adding, or use the Browse 
button to locate the entity on the local file system.
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6. Click OK, to add the entity, or Cancel, to cancel the operation.

Updating an Entity in a Folder

1. In the XML Finder dialog box, select the Repository tab.

2. In the tree-view, select the folder containing the entity you want to update. 

3. In the upper-right panel, select the entity you want to update and right-click.   

4. Select Update Entity from the pop-up menu. The Update Entity Definition dialog 
box is displayed, containing current information about the selected entity.

5. Change the contents of the Name, Description, and Notes fields as necessary. 

Note: You cannot change the entity content type using the Update Entity 
Definition dialog box. To change the type of an entity, you must create a 
new entity with the desired content type. For details, see “Adding an Entity 
to a Folder” on page 12-6.

6. In the Content URL field, enter the new URL of the entity, or use the Browse 
button to specify the new location of the entity in the local file system.

7. (Optional) Click View to display the contents of the updated entity.

8. Click OK, to update the entity, or Cancel, to cancel the operation.

Deleting an Entity From a Folder

1. In the XML Finder dialog box, select the Repository tab.

2. In the tree-view, select the folder containing the entity you want to delete. 

3. In the upper-right panel, select the entity you want to delete and right-click.   

4. Select Delete Entity from the pop-up menu. A dialog box is displayed prompting 
you to confirm the deletion.

5. Click Yes, to delete the entity, or No, to cancel the delete operation.
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Exporting an Entity

1. In the XML Finder dialog box, select the Repository tab.

2. In the tree-view, select the folder containing the entity you want to export. 

3. In the upper-right panel, select the entity you want to export and right-click.   

4. Select Export Entity from the pop-up menu. 

5. From the Look in drop-down list, select the folder to which you want to export 
the entity.

6. In the File name field, specify the name of the file to which you want to export 
the entity, or select an existing file.

7. Click Save, to export the entity, or Cancel, to cancel the operation.
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CHAPTER

13 Monitoring Workflows

The following procedures enable you to monitor workflows, at run time, in the Studio:

n Displaying Workflow Instances

n Viewing Workflow Status

n Viewing Workflow Variables

n Deleting Workflow Instances

n Viewing User Worklists

n Viewing Role Worklists

n Creating Workload Reports

n Creating Statistics Reports

Using the Workflow Monitoring Features

Use the BEA WebLogic Process Integrator workflow monitoring features to monitor 
and modify workflows, gather information, and make informed decisions based on 
available data. You can perform the following tasks:

n Display the status of workflow instances.

n Modify the tasks associated with a workflow instance, for example, reassigning 
tasks or forcing work to be redone.

n Graphically display the workload status of the system, showing the number of 
tasks categorized by status (pending, inactive, done, overdue) and user or role.
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n View historical statistical data associated with workflows in order to determine 
bottlenecks and inefficiencies in the business processes.

n View a user or role worklist in order to dynamically maintain workflows.

Displaying Workflow Instances

A workflow instance is a session of a workflow template definition that has been 
placed into run-time. To monitor the status of workflow instances:

1. Select a workflow template definition within a workflow template in the folder 
tree.

2. Right-click and choose Instances from the pop-up menu. 

This displays the Workflow Instance dialog box, which contains status 
information for the instances of the selected workflow template definition.

3. Select one of the following options:

l Started—Select this option to display all workflow instances with a start date 
in the specified date range. This option is mutually exclusive of the 
Completed option.

l Completed—Select this option to display all workflow instances with a 
completed date in the specified date range. This option is mutually exclusive 
of the Started option.

4. Select the date range for which you want to display workflow instances. Use the 
From and To drop-down lists as follows:

l Using the From drop-down list, select the date for which you want to start 
displaying workflow instances. Workflow instances started or completed 
(depending on the selected option) on or after this date will be shown.

l Using the To drop-down list, select the date for which you want to stop 
displaying workflow instances. Workflow instances started or completed 
(depending on the selected option) on or before this date will be shown.

For each workflow instance shown, the following information is displayed:
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n ID—workflow template definition ID. This is maintained automatically by the 
workflow engine from the expression specified in the properties at workflow 
template definition time.

n Started—date the workflow was instantiated.

n Completed—completion date of the workflow instance. If the workflow instance 
is not completed, this column will be blank.

For performance reasons, the BEA WebLogic Process Integrator server only returns 
100 items at a time. If there are additional items, a button (+) appears which, when 
pressed, retrieves the next 100 items. When no additional items remain, the button is 
no longer shown.

Viewing Workflow Status

1. In the Workflow Instances dialog box, select a workflow instance from the list of 
instances.

2. Right-click or double-click the selected instance to display a pop-up menu. Select 
Workflow Status from the menu to display the overall workflow status for the 
selected instance.

The Workflow Status command displays a window showing either the graphical 
representation of the workflow with the active task highlighted or a list view of 
all tasks. 

3. Click the graphical representation icon in the upper right corner to display a 
graphical representation of a workflow template definition that has been 
instantiated (is now an instance of the workflow template). 

4. In this view, the active tasks are green, the executed tasks are gray, and the 
inactive tasks are white.

5. Click the list icon in the upper right corner to display a list view of the workflow 
and its associated tasks. 

Various properties are displayed for each task within the workflow, depending 
on the way the list is tailored. Usually, the task name is shown in the list. The 
first column shown is the task status. A box indicates that the task is pending, or 
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waiting to be executed (it has a start date, but not a completed date). Tasks 
shown without a box are not yet in a state that allows them to be executed 
(meaning that they have neither a start date nor a completed date). A box with a 
check mark in it indicates a task that has already been completed (has a 
completed date). Furthermore, a pending task is shown with a red box, indicating 
the task is now overdue (meaning its due date is before the current date).

6. Right-click a task in the list to display a menu with the following options:

l Mark Task as Done—Select this option to change a task status to done. 
When executed, this command sends a message to the BEA WebLogic 
Process Integrator server to set the completed date for the task to the current 
date, and to then perform the actions defined for the marked done event of 
the task. Tasks can only be marked done if their properties allow it.

l Unmark Task Done—Select this option to reset a task status to change it 
back to pending. When executed, this command sends a message to the BEA 
WebLogic Process Integrator server to clear the completed date for the task. 
It has no effect on a task that is not complete. Tasks can only be unmarked 
done if their properties allow it.

l Reassign Task—Select this option to reassign a task to another user or role. 
When executed, this command displays the Reassign Task dialog box. Use 
this dialog box to select a new user or role to which to assign the task.

A task can be assigned to a user, a user within a role (determined by the 
workflow engine so that workload balancing is automatically done), or a 
role. When a selection is made, a message is sent to the BEA WebLogic 
Process Integrator server to set the task's assignee to the selected user or role.

Tasks can only be reassigned if their properties allow reassignment of tasks, 
and the task is not already done.

l Task Properties — Select this option to display and change the properties of 
the selected task. When executed, the Task Properties dialog box is 
displayed.

To change the properties of a task, select the Priority and Task Permissions 
using the guidelines provided in the following table. Then click OK to accept 
the changes, or Cancel, to cancel the operation.
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Viewing Workflow Variables

1. In the Workflow Instances dialog box, select a workflow instance from the list of 
instances.

2. Right-click or double-click the selected instance to display a pop-up menu. Select 
Variables from the menu to display the Workflow Variables dialog box. 

Priority

n Low 

n Medium

n High

Select the task priority from the drop-down list.

Task Permissions

Mark done without 
executing

Select this check box to allow any end user assigned to this task 
to perform the Mark Task as Done command from the Worklist 
application. The completed date for the task can be set manually 
by the end user.

Re-execute if marked 
done

Select this check box to allow any end user assigned to this task 
to perform the Execute Task command from the Worklist 
application, even if the task has already been completed.

Unmark if marked done Select this check box to allow any end user assigned to this task 
to perform the Unmark Task as Done command on the task from 
the Worklist application.

Modify at execution time Select this check box to allow any end user assigned to this task 
to change the task permissions by selecting Properties from the 
Task menu of the Worklist application. If this check box is not 
selected, then none of the task permissions can be altered.

Reassign at execution 
time

Select this check box to allow any end user assigned to this task 
to perform the Take and Reassign commands from the Worklist 
application, meaning they can take the task as their own 
responsibility or reassign it to another user.
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The Workflow Variables dialog box displays each variable in a list, showing its 
name and its current value. Use the buttons on the dialog box as follows:

l Update—Select a variable and click Update to display the Set Variable 
dialog box. Double-clicking the selected variable also displays the Set 
Variable dialog box. 

The dialog box displays the current value of the variable. To change the 
value of the variable, if desired, enter the new value in the Value field and 
click OK. Click Cancel to leave the value of the variable unchanged.

If you change the value of a variable, a message is sent to the BEA 
WebLogic Process Integrator server to reset the variable. Because workflow 
logic often depends on the value of variables, use caution when manually 
changing the value of a variable.

l Show XML—Select an XML-type variable and click Show XML to display 
the XML contents of the variable.

Deleting Workflow Instances

1. In the Workflow Instances dialog box, select a workflow instance from the list of 
instances.

2. Right-click or double-click the selected instance to display a pop-up menu. Select 
Delete from the menu to display the Delete Workflow dialog box. 

3. Click Yes to delete the workflow instance, or Cancel, to cancel the delete 
operation. If you click Yes, a message is sent to the BEA WebLogic Process 
Integrator server prompting the deletion of the selected workflow instance.

Viewing User Worklists

In the BEA WebLogic Process Integrator folder tree, right-click a user from the list and 
select Open User Worklist from the pop-up menu. A list of tasks assigned to the user 
is displayed. 
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Note: You cannot execute tasks on worklists invoked from within the Studio. To 
execute tasks from a worklist you must invoke a worklist client application.

Viewing Role Worklists

In the BEA WebLogic Process Integrator folder tree, right-click a role from the list and 
select Open Role Worklist from the pop-up menu. A list of tasks assigned to the role 
is displayed. 

Note: You cannot execute tasks on worklists invoked from within the Studio. To 
execute tasks from a worklist you must invoke a worklist client application.

Creating Workload Reports

BEA WebLogic Process Integrator allows you to view workload reports, showing the 
number of tasks, by workflow, task, user or role, and task status. 

To create a workflow report:

1. In the BEA WebLogic Process Integrator folder tree, right-click Workload Report, 
and choose Open from the pop-up menu. 

The Workload Report Properties dialog box is displayed, containing a list of all 
the workflow templates in the organization.

2. Select the workflow templates to include in the report as follows:

l Select All Workflows to display information in the report for all the 
workflow templates in the organization.

l Select a workflow template to display information in the report for all 
workflow template definitions within that workflow template

l Expand a workflow template and select a specific workflow template 
definition to display information in the report for only the selected template 
definition. 
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Only information within the selected workflow template or workflow template 
definition will be included in the workload report.

3. Select the types of tasks to include in the report as follows:

l Pending—displays pending tasks. Pending tasks have been started and not 
yet completed.

l Inactive—displays inactive tasks. Inactive tasks are those which have not yet 
been started.

l Done—displays completed tasks. 

l Overdue—displays those tasks which are now overdue. Overdue tasks are 
pending tasks with a due date on or before the current date.

l Total Tasks—displays all tasks, regardless of task state (that is, inactive, 
pending, and completed tasks are all counted).

4. Select the users and roles to include in the report as follows:

l All users—displays workload information for each user.

l All roles—displays workload information for each role.

l Specified users—displays workload information for each of the users you 
select from the list of users that is displayed.

l Specified roles—displays workload information for each of the roles you 
select from the list of roles that is displayed.

l Users of specified roles—displays workload information for each user who is 
a member of one of the selected roles in the list of roles that is displayed.

l Group together and display totals only—displays total counts of tasks only 
for the group of users or roles selected. If you do not select this check box, 
each individual user or role is shown in the workload report. 

5. Click OK to create the workload report, or Cancel, to cancel the operation.

If you select OK, a graphical representation of the current workflow is 
displayed.

6. To change the information displayed in the report, click Rebuild.

The Workload Report Properties dialog box is displayed.

7. Make changes as desired and click OK, to display the changed workload report, 
or Cancel, to cancel the changes. 
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Creating Statistics Reports

You can view statistics reports that are based on tasks, users, and roles. A statistics 
report provides statistical information based on historical data kept for completed 
workflows. It shows number of tasks completed, total time, average time, minimum 
and maximum times spent for task. Standard deviation is also shown.

To create a statistics report:

1. In the BEA WebLogic Process Integrator folder tree, right-click Statistics Report, 
and choose Open from the pop-up menu. 

The Statistics Report Properties dialog box is displayed, containing a list of all 
the workflow templates in the organization.

2. Expand the appropriate template and select the workflow template definition to 
be included in the report. Only tasks within the selected workflow template 
definition are included in the statistics report.

3. Select the dates to be included in the statistical calculations as follows:

l For all dates—select this check box to gather statistical calculations 
regardless of date. If you clear this check box, you can specify a date range 
using the From and To drop-down lists.

l From—select the date on which you want to start including the statistics. All 
tasks, in completed workflows, completed on or after this date are included 
in the statistical calculations. 

l To—select the date on which you want to stop including the statistics. All 
tasks, in completed workflows, completed on or before this date are included 
in the statistical calculations.

4. Select the users and roles to include in the report as follows:

l All users—displays statistical information for each user.

l All roles—displays statistical information for each role.

l Specified users—displays statistical information for each of the users you 
select from the list of users that is displayed.

l Specified roles—displays statistical information for each of the roles you 
select from the list of roles that is displayed.
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l Users of specified roles—displays statistical information for each user who is 
a member of one of the selected roles in the list of roles that is displayed.

l Group together—displays statistics only for the group of users or roles 
selected. If you do not select this check box, each individual user or role is 
shown in the statistics report. 

5. Click OK to create the statistics report, or Cancel, to cancel the operation.

If you select OK, a statistics report is displayed.

The contents of the statistics report are described in “Viewing Statistics Reports” 
on page 13-10.

Viewing Statistics Reports

Several columns are displayed in the statistics report, depending on the options 
selected when you created the report. The following table describes each column in the 
report.

You can customize the statistics report view as follows:

Column Description

Task Name of the task being measured.

User User or role assigned to the task. If the Group together check box 
was selected when you created the report, this column is not 
shown. In this case, the results are totaled for all users.

Number Total number of tasks completed.

Total Total amount of time spent on doing the task. This is the time 
interval between the task start date and completed date.

Average Average amount of time spent performing this task.

StdDev Standard deviation.

Min Minimum amount of time to spend performing this task.

Max Maximum amount of time to spend performing this task
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l Specify the unit of time to be used in the report by selecting one of the 
following option buttons:  Seconds, Minutes, Hours, and Days.

l Specify the decimal precision to be used in the report using the Precision 
drop-down list.

To change the information displayed in the statistics report:

1. Click the Build/Rebuild report button. 

The Statistics Report Properties dialog box is displayed. 

2. Make changes as desired and click OK, to display the changed statistics report, or 
Cancel, to cancel the changes. 

Because the report definition is stored separately from the results, the statistics report 
can be run at any time.
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